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About This Tutorial 

The Clarus 600/560 D MS Tutorial is your initial guide to using the TurboMass 
software with either the Clarus 600 MS or the Clarus 560 D MS. This tutorial is 
designed to teach you basic operating procedures by using typical examples. More 
specifically, this tutorial begins by showing you how to prepare the hardware. Next, 
it shows you how to start the TurboMass software, develop GC and MS methods, 
create and run a sample list, and analyze the data obtained. 

After completing this tutorial, you will have the background information required 
to explore and use all of the features described in the TurboMass Software User’s 
Guide (P/N 09936767).  

In addition, this tutorial provides the basis for operating TurboMass for Environmental 
Reporting.  For detailed operating procedures for Environmental Reporting, refer to 
the Clarus MS Environmental Tutorial – Basic Principles (P/N 09936770). 
 



Clarus 600/560 D GC/MS Tutorial 

12 

Prerequisites 

Before operating the Clarus 600 MS or Clarus 560 D MS system you should: 

 Thoroughly understand the recommended safety practices. Read the Warnings 
and Safety Information section in the Clarus 600/560 D GC/MS Hardware 
Guide (P/N 09936768). 

 Have a basic understanding of how to use the Clarus GC, computer, and 
Microsoft Windows. For details, refer to the corresponding manuals 
provided with each product. 

This tutorial is presented with the assumption that you have a basic familiarity with 
Microsoft Windows operations. If you need a refresher about the basic principles of 
Microsoft Windows, such as opening and closing files, adjusting the window size or 
position, printing, or using the Windows Explorer, refer to your printed Microsoft 
Windows documentation, or online Help files, for details.  
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About the Clarus 600 GC/MS System 

The Clarus Mass Spectrometer is a sophisticated benchtop mass spectrometric 
detector that provides you with the simple tools needed to perform routine gas 
chromatography/mass spectrometry (GC/MS) analyses as well as the sophisticated 
tools needed to perform the more complex analyses. Clarus MS runs analyses that 
best characterize your sample by using either the electron ionization (EI) mode or 
chemical ionization (CI) mode. Designed as a detector for the Clarus 600 GC, this 
system produces positive identification and quantification of compounds separated 
by the Clarus GC, even those complex compounds that coelute. 

Clarus 6 00
Gas  Chromatograph

Clarus 600
Mass Spectrometer

 
Figure 1 The Clarus 600 MS system 
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The Clarus 600 MS is controlled by a personal computer (PC) based data system 
using the Microsoft Windows operating environment. The TurboMass software user 
interface contains color graphics and provides full user interaction by using either 
the keyboard or the mouse. Clarus 600 completely controls the GC/MS system from 
tuning and data acquisition (scanning or selected ion recording mode) through 
quantifying your results. Complete operating instructions of all Clarus 600 controls 
are in the TurboMass Software User’s Guide (P/N 09936767) and TurboMass on-
line help file, supplied with the system. 

A high-performance, research-grade analytical quadrupole mass analyzer with a 
quadrupole prefilter assembly transmits only those ions having your selected mass-
to-charge ratio. The prefilter assembly protects the analytical quadrupole rods from 
contaminating ion deposits. 

Ions emerging from the quadrupole mass analyzer are detected by the 
photomultiplier detector system. The low noise photomultiplier typically operates 
with a gain of 105 that amplifies the ion current collected. 

Vacuum Pump Options 
The Clarus 600 MS offers three different vacuum pump capacities. The 
turbomolecular and diffusion pump options are designed to fit your applications, 
performance and budgetary needs.  

Turbomolecular Pump 
Clarus 600 MS has two turbomolecular pump options in three configurations. 
Turbomolecular pumps are high-speed turbines which transport the sample and 
carrier gas molecules away from the mass spectrometer.   

 Clarus 600 S - The 70 L/sec turbomolecular pump supports Electron Ionization 
operation (EI) and has optional water cooling. 

 Clarus 600 T – All of the functions and options of the Clarus 600 S with a  
255 L/sec turbomolecular pump for higher column flow rates, pump-down time 
under three minutes, and lower detection limits 

 Clarus 600 C - All of the functions and options of the Clarus 600 T with 
positive and negative Chemical Ionization (CI) operation. 
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Diffusion Pump 

Clarus 600 D MS has a 60 L/sec air-cooled oil diffusion pump. This pump is only 
available for Electron Ionization (EI) operation. 

Pump fluid (Santovac® 5P Ultra) is heated in the base of the pump to produce a 
vapor which passes through the interior of the jet assembly and emerges from the 
jets as high-velocity vapor streams. These streams entrain eluting compounds and 
carrier gas, condense on the cooled pump body wall, and drain into the base of the 
pump for recirculation.  The entrained compounds are transferred to the forepump. 

The diffusion pump system has a manual vent switch. This manual vacuum venting 
is controlled by a push button toggle switch and a pump temperature sensing 
switch.  When you push the button in, the vent is opened.  When the button is up 
(not pushed in), the vent is closed. 
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About the Clarus 560 D GC/MS System 

The Clarus 560 D Mass Spectrometer is a sophisticated benchtop mass 
spectrometric detector that provides you with the simple tools needed to perform 
routine gas chromatography/mass spectrometry (GC/MS) analyses as well as the 
sophisticated tools needed to perform the more complex analyses. Clarus 560 D MS 
uses a diffusion pump vacuum system to run analyses that best characterize your 
sample by electron ionization (EI). Designed as a detector for the Clarus 500 GC, 
this system produces positive identification and quantification of compounds 
separated by the Clarus GC, even those complex compounds that coelute. 

Clarus 6 00
Gas  Chromatograph

Clarus 600
Mass Spectrometer

 
Figure 2 The Clarus 560 D MS system 
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The Clarus 560 D MS is controlled by a personal computer (PC) based data system 
using the Microsoft Windows operating environment. The TurboMass software user 
interface contains color graphics and provides full user interaction by using either 
the keyboard or the mouse. Clarus 560 D completely controls the GC/MS system 
from tuning and data acquisition (scanning or selected ion recording mode) through 
quantifying your results. Complete operating instructions of all Clarus 560 D 
controls are in the TurboMass Software User’s Guide (P/N 09936767) and 
TurboMass on-line help file, supplied with the system. 

A high-performance, research-grade analytical quadrupole mass analyzer with a 
quadrupole prefilter assembly transmits only those ions having your selected mass-
to-charge ratio. The prefilter assembly protects the analytical quadrupole rods from 
contaminating ion deposits. 

Ions emerging from the quadrupole mass analyzer are detected by the photomultiplier 
detector system. The low noise photomultiplier typically operates with a gain of 105 
that amplifies the ion current collected. 

About the Diffusion Pump 

Clarus 560 D MS has a 60 L/sec air-cooled oil diffusion pump. This pump is only 
available for Electron Ionization (EI) operation. 

Pump fluid (Santovac® 5P Ultra) is heated in the base of the pump to produce a 
vapor which passes through the interior of the jet assembly and emerges from the 
jets as high-velocity vapor streams. These streams entrain eluting compounds and 
carrier gas, condense on the cooled pump body wall, and drain into the base of the 
pump for recirculation.  The entrained compounds are transferred to the forepump. 
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The diffusion pump system has a manual vent switch. This manual vacuum venting 
is controlled by a push button toggle switch and a pump temperature sensing 
switch.  When you push the button in, the vent is opened.  When the button is up 
(not pushed in), the vent is closed. See the following illustration. 

Reference
Gas Vial

(P/N E640-1384)

Knurled Nut

Access Door

Manual Vent Valve
(Diffusion Pump Only)

Black Knurled Knobs

Inner Source

 

When the pump is hot, the temperature sensing switch will prevent the vent valve 
from working.  

 
CAUTION 

If you try to vent a hot diffusion system, oxidation of the pump oil may 
occur and cause oil to enter the analyzer tub which will damage the 
instrument. 
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The depressed push-button vent switch lights when venting is allowed. Before 
selecting Pump/Vacuum System On, close the vent switch (the button is up and the 
light is off) 
To prevent damage to the oil and pump not covered under Warrantee, never 
vent when: 

• Diffusion pump is hot 
• During 20 minute cool-down 

NOTE: The vent valve will operate if the vent switch is pushed in (on) before the diffusion 
pump becomes hot.  This includes the first few minutes of Pump/Vacuum System 
On.  Venting during this period may cause a vacuum fault to occur and risk 
backstreaming the diffusion oil into the analyzer. It is a good reminder to leave the 
instrument front door open whenever the push button switch is pushed in (on). 

NOTE: When the diffusion pump is hot, the vent switch will not light when pushed in (on). 
Since the vent switch may be left in the depressed position at any time, you should be 
careful to avoid closing the instrument door and forgetting that the push button 
switch is pushed in.  (When the diffusion pump cools, the pushed in, push button 
switch will light and automatically vent the system). 

Vacuum Gauge 

The Clarus MS systems use a single wide-range vacuum gauge that monitors the 
system pressure from atmosphere down to 10-9 Torr using a combined Pirani/Inverted 
Magnetron ionization sensor. 

Normal operating pressure with 1 mL/min helium for the 255 L/sec turbomolecular 
pump is between 9x10-6 Torr and 2x10-5 Torr after pump-down and ion source bake-
out.  The 70 L/sec turbomolecular and the diffusion pumps will operate at somewhat 
higher pressures. 
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Basic GC/MS 

As its name implies, this important analytical technique is composed of parts, gas 
chromatography (GC) and mass spectrometry (MS), which have been combined. 
Historically, both individual techniques are quite old. GC was developed as a means 
for separating mixtures into their component substances and provided a big step 
forward in the analysis of mixtures.  

Figure 3 summarizes the GC process. It shows that by passing a mixture in a gas 
stream (the gas phase) through a long capillary column with the inside walls thinly 
coated with a liquid (the liquid stationary phase), the components of the mixture 
separate and emerge (elute) one after another from the end of the column. 

In a simple GC instrument, the emerging components are either burnt in a flame for 
detection (the popular flame ionization detector, FID) or passed to atmosphere after 
traversing some other kind of detector. The detected components are recorded as 
peaks on a plot (the gas chromatogram). Information on the possible identity of the 
component is found by measuring the resulting area and height of a chromatographic 
peak. This corresponds with the amount of a component detected and the time it takes 
that component to pass through the column. The measured time to the peak maximum 
is the retention time. This identification is seldom absolute and is often either vague or 
not possible at all. 
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Figure 3 Schematic diagram of a gas chromatograph showing an injection of a 
mixture of four substances (A, B, C and D) onto a GC column, followed by 
their separation into individual components, their detection and the display 
(gas chromatogram) of the separated materials emerging at different times 
from the column 

In complete contrast to a GC, a mass spectrometer is generally not useful for dealing 
with mixtures. If a single substance is put into a mass spectrometer, its mass 
spectrum can be obtained using a variety of ionization methods (Figure 4). Having 
obtained the spectrum it is then often possible to make a positive identification of 
the substance or to confirm its molecular structure. Clearly, if a mixture of 
substances were put into the MS, the resulting mass spectrum would be a summation 
of the spectra of all the components (Figure 5). 
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Figure 4 Schematic diagram of a mass spectrometer. After inserting a sample 
(A) it is ionized, the ions are separated according to their m/z value and, finally, 
the numbers of ions (abundance) at each m/z value are plotted against m/z to 
give the mass spectrum of A. By studying the mass spectrum, sample A will be 
identified 

This spectrum could be extremely complex and it would be difficult or impossible to 
positively identify the various components. Thus, there is one instrument (the GC) 
that is highly efficient for separating mixtures into their components but is not good 
on identification and another instrument (the MS), which is efficient at identifying 
single substances, but is not good with mixtures. It is not surprising to find early 
efforts being made to combine the two methods into one system (GC/MS) capable 
of separating, positively identifying, and quantifying complex mixtures, provided 
these could be vaporized. 
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Combining GC and MS was not without its problems (see The Connection between 
GC and MS on page 24) but modern GC/MS is now a routinely used methodology in 
many, many areas, ranging from interplanetary probes to finding levels of dioxins in 
environmental dust samples. Further, the addition of GC to MS does not simply give 
a sum of the two alone; the information provided by combined GC/MS yields 
information that could not be extracted from the isolated techniques, an aspect 
which is discussed below. 

 
Figure 5 By way of illustration, very simple spectra for four substances (A, B, 
C, and D) are shown; (a) separately, and (b) mixed in unequal proportions. In 
the mixture spectrum it is virtually impossible to decode A, B, C and D if they 
are not know to be present 
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The Connection between GC and MS 

As previously described, the mobile phase carrying mixture components along a gas 
chromatographic column is a gas, usually helium. This gas flows at or near atmospheric 
pressure at a rate of generally about 0.5 to 3.0 mL/min and flows out of the end of the 
capillary column into the ion source of the mass spectrometer. The ion sources in 
GC/MS systems normally operate at about 2 x 10-5 Torr with 1.0 mL/min helium 
flowing into the manifold for electron ionization to about 3 x 10-4 Torr for chemical 
ionization. 

This large pressure change between the end of the chromatographic column and the 
inside of the ion source causes the gas to expand to a flow equivalent to several 
liters per minute. Therefore, large pumps are required to remove the excess of gas 
and maintain the vacuum inside the source near that which is optimum for 
ionization. 

In modern GC/MS installations, the use of capillary chromatographic columns and 
high-speed pumps means that the end of the column can be literally right inside the 
ion source. In older GC/MS instruments, gas flow rates were much greater and it 
was necessary to have an interface between the end of the column and the ion 
source. 

This interface or separator removed much of the GC carrier gas without also 
removing the eluting mixture components that traveled on into the ion source. A 
most popular form still to be found occasionally was the jet separator. 

Recording Mass Spectra 

As each mixture component elutes and appears in the ion source, it is normally 
ionized either by an electron beam (electron ionization) or by a reagent gas 
(chemical ionization) and the resulting ions are analyzed by the mass spectrometer 
to give a mass spectrum (Figure 6). 
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Figure 6 In a GC/MS combination, passage of the separated components (A, B, 
C and D) successively into the mass spectrometer yields their individual spectra 

For capillary GC, separated mixture components elute in a short time interval, often 
only lasting a few seconds. Thus, the amount of any one component in the ion 
source is not constant as its mass spectrum is being obtained but, rather, it starts off 
as zero, rises rapidly to a maximum, and then drops rapidly back to zero. 

If this passage through the ion source is faster than the mass spectrometer can scan 
the spectrum, then a true spectrum will not be found because the start of the scan 
will see less compound than at the middle of the scan and less again near the end. 
This changing concentration of the eluting component results in a distorted mass 
spectrum that might well not be recognizable (Figure 7). The answer to this problem 
is to scan the spectrum so fast that, in effect, the concentration of the eluting 
component has scarcely changed during the time needed for a spectrum. 
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Figure 7 Slow scanning (i) of the mass spectrum over a GC peak for substance 
A produces a spectrum (a), but rapid scanning (ii) gives spectrum (b) which is 
much closer to the true spectrum (c) 

For a quadrupole mass spectrometer this high rate of scanning is not difficult 
because it requires only simple changes in some electrical voltages and these 
changes can be made electronically at very high speed. This is one reason for 
quadrupoles being popular in GC/MS combinations. In the early days of magnetic 
sector mass spectrometers the required scanning speed was just not possible because 
of serious hysteresis effects in the magnets. With modern magnet technology, 
scanning can be done at high speed with insignificant hysteresis. 

As described above, the concentration of an eluting component in the ion source 
goes from zero to zero through a maximum. Usually, the greater the amount of a 
substance in an ion source the better the resulting mass spectrum, within reason. 
This suggests that the best time for a scan will be near the maximum concentration 
(the top of a GC peak) and that the instrument operator must watch the developing 
chromatogram continually, trying to judge when best to measure a spectrum. 

The answer has been to simply set the mass spectrometer to scanning continuously. 
As the mixture is injected onto the chromatographic column, repetitive scanning is 
instituted over a preset mass range (for example, 50 – 500 mass units) at a preset 
interval (for example, every ½ second). Thus, scan follows scan right through the 
chromatogram and, literally, hundreds of mass spectra may be recorded in a routine 
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GC/MS experiment (Figure 8). Data flows from the mass spectrometer at such a 
high speed that a microprocessor/computer is absolutely necessary to process it. 

 
Figure 8 A typical gas chromatogram showing three components (A, B and C) 
emerging at different times. Continuous scanning for mass spectra is started at 
zero and scans are repeated regularly (small tick marks). Thus, peak A is 
scanned five times during its passage through the ion source. Because scanning 
is regular, the “time” axis can be replaced by a scan number axis 

At the end of a GC/MS run all of the data are stored, usually on a hard disk in the 
computer, in the form of a mass spectrum for every scan that was done. These 
spectra can then be manipulated. For example, the scan corresponding to the top of a 
chromatographic peak can be selected (scan 3 or 4 in Figure 8 for example) and the 
mass spectrum displayed or printed out. As a routine, the computer adds up all the 
ion peaks in each mass spectrum to give a total ion current for the mass spectrum. 
These total ion currents are then plotted along an x-axis (time for elution) and a y-
axis (amount of total ion current) to give a total ion current chromatogram (TIC) 
showing the elution of all the components of a mixture. Storage of all these data has 
other major advantages. 

Manipulation of Scan Data 

Some ways in which data can be utilized are described briefly below. 

Background Subtraction 

Gas chromatograms are often obtained by running the column at a sufficiently high 
temperature. This causes the stationary liquid phase on the column walls to 
volatilize to a noticeable extent and it too begins to elute in the mobile gas stream 
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from the end of the column. This effect is column bleed. Clearly, if the liquid phase 
is eluting all the time, it must reach the ion source when there is and even when 
there is not an eluting mixture component and, since the spectrometer scans 
continuously, the mass spectrum of the column bleed is recorded continuously. 
Therefore, the recorded spectrum for an eluting component will not be pure but will 
be mixed with that from the column bleed. 

Fortunately, it is a fairly simple matter to get the computer to subtract the known 
column bleed spectrum from the mixed spectrum so as to obtain the desired pure 
spectrum of the eluting component. This process is called background subtraction 
and is usually carried out routinely before a library search (next item) or before the 
spectrum is printed out (Figure 9). 

 
Figure 9 Column bleed will give a mass spectrum (a), which is mixed with that 
of an eluting component to give a complex spectrum (b). By subtracting (a) 
from (b) the true spectrum (c) of the eluting component is obtained 

Identifying the Component 

After obtaining a good pure mass spectrum from an eluting component, the next step 
is to try to identify the component either through the skill of the mass spectroscopist 
or by resorting to a library search. Most modern GC/MS systems with attached data 
station include a large library of spectra from known compounds (for example, the 
NIST library). There may be as many as 60,000 - 220,000 stored spectra, covering 
most of the known simple volatile compounds likely to be met in analytical work. 
By special search routines under the control of the computer, this huge database can 
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be examined very quickly, comparing the mass spectrum of the eluted mixture 
component with each of the library spectra. The computer then provides a short list 
of the best matches between the library spectra and the measured one. Often, from 
the goodness of match or fit and its chromatographic retention time, the eluted 
component can be identified. 

Resolution Enhancement 

Sometimes a single peak from a gas chromatogram may actually be due to not just 
one eluting substance but to two, three, or more substances all eluting very close 
together. By examining the scans across the peak and using a simple mathematical 
process, the computer is able to reveal the existence of more than one eluting 
component in a single peak and print out the mass spectra of the discovered 
components. This is a form of resolution enhancement. The GC/MS combination 
has been able to do what neither the GC nor the MS alone could do. In effect the 
mass spectrometer has improved (enhanced) the resolution of the gas chromatograph 
(Figure 10). 

 
Figure 10 A single peak from an ordinary gas chromatogram (a) is revealed as 
two closely separated peaks by resolution enhancement (b) 
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Identifying a Series of Compounds 

There could be a series of compounds, designated RX, in which the part R was the 
same for all but X was different. In such a series the part R can give a characteristic 
ion, that is, the mass corresponding to R is the same for every member of the series. 
When one member of such a series elutes from the chromatographic column its 
resulting mass spectrum will always contain one mass common to the whole series. 
Therefore, even if the series is mixed with other compounds, its members can be 
recognized from the characteristic ion. It is a simple process to get the computer to 
print out a chromatogram in which only those scans which contain the characteristic 
ion are used to draw the chromatogram. Basically, the output is blind to any 
component other than those containing an R group. Such a selected chromatogram is 
called a mass chromatogram and is useful for pinpointing where certain compounds 
elute without the need for examining all the spectra (Figure 11). 

 

Figure 11 (a) A typical total ion current gas chromatogram showing many 
components, some of which have a part (R of characteristic mass, say 91). (b) A 
mass chromatogram based on m/z 91. The same data as used in (a) are plotted but 
now manipulated so that only ion currents corresponding to m/z 91 are shown. 
Note the decrease in complexity, making the desired identification much easier 

Identifying Specific Compounds 

In a process somewhat similar to that described above, the stored data can be used to 
identify not just series of compounds but specific ones. For example, any compound 
containing a chlorine atom is obvious from its mass spectrum because natural 
chlorine occurs as two isotopes, 35Cl and 37Cl in a ratio of 3:1. Thus, its mass 
spectrum will have two molecular ions separated by two mass units (35 + 2 = 37) in 
an abundance ratio of 3: l. It becomes a trivial exercise for the computer to print out 
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only those scans in which two ions are found separated by two mass units in the 
abundance ratio of 3:1 (Figure 12). 

 
Figure 12 (a) A typical total ion current chromatogram showing many components 
of a mixture. The aim is to find if any methyl chloride (CH3Cl; RMM = 50, 52) is 
present. To this end, the data (or a new chromatogram) are scanned at two specific 
positions: (b) at m/z 50 and (c) at m/z 52 
Note how m/z 50, 52 both reach a maximum at the same scan and have a ratio in 
peak heights of 3:1 (35CI:37CI = 3:1). Such an experiment in selected ion recording 
identifies the suspected component against a complex background and can be very 
sensitive 

This selection of only certain ion masses is called selected ion recording (SIR) or 
selected ion monitoring (SIM). 
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The ions selected for such recording can be one, two, three or more (multiple ion 
recording). In fact, through judicious choice of ions, the method can be so selective 
that a chosen component can be identified and quantified even though it could not 
even be observed in the original total ion current chromatogram. This very powerful 
technique is frequently used in examinations of extremely complex mixtures in 
which it is desired to identify small amounts of a particular substance in a mass of 
other things, as with detection of banned drugs in the body fluids of athletes or 
racehorses. 

Conclusion 

By connecting a gas chromatograph to a suitable mass spectrometer and adding a 
data system, the combined method of GC/MS can be used routinely for separation of 
complex mixtures into their individual components, identification of the components, 
and estimation of their amounts. This technique is in very widespread use. 

 

Definition of Terms and Abbreviations 

The terms and abbreviations used in this tutorial are described in the Glossary of 
Mass Spectrometry Definitions and Terms in Chapter 3 of the Clarus 600/560 
GC/MS Hardware Guide (P/N 0993-6768). Additional Reading-Bibliography of 
GC/MS Books. 

Basic Introductions to GC/MS 

Message, Gordon M. Practical Aspects of Gas Chromatography/Mass Spectrometry. 
John Wiley & Sons, 1984. 

Middleditch, Brian S. Practical Mass Spectrometry. Plenum Press, 1979. 

Watson, J. Throck. Introduction to Mass Spectrometry. Raven Press, 1997. 
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Davis, Reg, and Frearson, Martin. Mass Spectrometry: Analytical Chemistry by 
Open Learning. edited by F. Elizabeth Prichard. John Wiley & Sons, Pub., 1999. 

Dawson, Peter H. (Editor). Quadrupole Mass Spectrometry and Its Applications. 
Amer Inst of Physics, 1995. 

Harrison, Alex G. Chemical Ionization Mass Spectrometry. CRC Press, 1992. 

Mass Spectrum Interpretation 

McLafferty, F.W. Interpretation of Mass Spectra. University Science Books, 4th ed., 
1993. 

McLafferty, Fred W. and Venkataraghaven, Rengachari. Mass Spectral Correlations 
2nd Ed. American Chemical Society, Advances in Chemistry Series #40, 1982. 
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Computer Requirements 

Computer and System Software Requirements 

To ensure that your system performs at the expected high level, your computer must 
be configured to the minimum capabilities indicated below. 

These requirements may be updated as the requirements for TurboMass software 
and/or Microsoft Windows XP SP2 are changed. Consult your PerkinElmer support 
engineer for current requirements. 

NOTE:  This guide does not cover the installation and configuration of your computer. If 
you have purchased a complete system from PerkinElmer, the computer will already 
have been configured. 

PC Requirements 

The TurboMass software is installed at PerkinElmer prior to shipment and tested 
using the following minimum PC system specifications. If you need to reinstall the 
software, verify that the PC meets the following minimum requirements: 

• Dell GX620, GC270, GX 280, or OptiPlex 745  

• Intel® Pentium processor  

• 512 MB of Random Access Memory (RAM) 

• High Color (16 bit) at 1024 x 768 SVGA 

• Hard disk with 2.0 GB free space 

• 8x speed CD-ROM drive 

• 1 RS-232 port  

• 2 RJ-45 10/100Base-T ports 

• A keyboard and PS/2®-style mouse 
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Operating System 
 Windows XP SP2  

Software  
TurboMass Software.  

Instrument Firmware Versions  
Internal dotLINK 

Printers 
• HP LaserJet 4200 Printer Series (HP 4200, 4210, and 4250) 

• HP DeskJet 5650 Color InkJet Printer 

NOTE:  Using any printers other than the ones recommended above may not correctly 
display the Communiqué reports. 
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Conventions Used in This Manual 

Normal text is used to provide information and instructions. 

Bold text refers to text that is displayed on the screen. 

UPPERCASE text, for example ENTER or ALT, refers to keys on the PC 
keyboard. ‘+’ is used to show that you have to press two keys at the same time, for 
example ALT + F. 

Three terms (Note, Caution and Warning) are used in the text. Each one implies a 
particular level of observation or action as follows: 

NOTE:  A note indicates additional, significant information that is provided with some 
procedures. 

 

 
CAUTION 

A caution indicates an operation that could cause instrument damage 
if precautions are not followed. 

 

 
WARNING 

A warning indicates an operation that could cause personal injury if 
precautions are not followed. 
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Clarus GC 

You operate and control the Clarus 600 GC (or if you have a Clarus 560 D MS, the 
Clarus 500 GC) using the GC control section of the TurboMass software and/or the 
GC touch screen. The GC touch screen contains active areas that you touch to 
perform the required action. 

You may find it more convenient to use a stylus or you may like to use your fingers 
to touch the active areas of the touch screen. Do not use sharp, pointed objects. A 
light touch is all that is needed. You do not need to press forcefully on an active 
area. 

Please note that when you touch an active area, various processes are started in the 
instrument. Some of these processes may take several seconds. Be patient and wait 
for the process to complete before touching another active area on the touch screen. 

When the GC is under the TurboMass software control, some functions are not 
available for use on the touch screen. 
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Touch Screen 

The main displays on the touch screen are termed screens. You use various screens 
to set up your Clarus GC to perform the analyses. These screens contain: 

• Entry fields which allow you to make entries, 

• Buttons that you touch to start or stop actions or to display a dialog, 

• Option Buttons that you select an option from a list and 

• Boxes that you use to switch functions on or off. 

The Clarus GC is controlled by a collection of operating parameters called the 
Active Method.  You can prepare and save up to five methods and make any one of 
them the Active Method.  However, the fifth method is reserved for TotalChrom and 
may be overwritten. 

The following Status screen shows the different sections of the user interface. 

The Status Screen displays icons that provide quick access to major areas of the 
system. The injector and detector buttons show graphic representations of the 
devices for each channel. If an auxiliary zone is configured, the Aux button appears 
below the Oven button. The icon buttons that represent the heated zones (injectors, 
detectors, oven, and Aux if configured) include a light to indicate the ready/not 
ready status. A red blinking light indicates not ready and a steady green light 
indicates ready status.    
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Starting the Clarus MS from a Cold State 

This chapter describes how to start the Clarus MS from a cold state. This implies that 
the system is off. Before starting the Clarus MS system, first verify that the hardware is 
properly connected. After verifying that the hardware is properly connected, you can 
start your Clarus MS system and bring it to the point where you are ready to create a 
GC/MS method. 

The following steps summarize the procedure for staring the Clarus GC/MS system from 
a cold state:  

1. Verify hardware connections. 

2. Verify sufficient carrier gas to the Clarus GC.  

3. Turn on all instruments. 

4. Set the Clarus GC to communicate with the mass spectrometer. 

5. Start Clarus GC and Clarus MS. 

Verifying hardware connections 

Before turning on any instrument, answer the following questions: 

• Are the gas lines connected to the GC?  Are they leak-free? 

• Is the mass spectrometer vacuum line connected to the forepump? 

• Are all AC line cords plugged-in to the proper AC voltage outlets? 

• Is the proper source (EI or CI) installed for your analysis? 

• Is the mass spectrometer forepump plugged into the outlet on the rear of the 
mass spectrometer and the power switch set to ON? 

• Is one end of the GC start cable connected to the plug located in the lower right 
rear of mass spectrometer? 
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• Is the other end of the GC start cable connected to terminals 7 and 8 (Start Out) on 
TB1 in the Clarus GC? 

Rear of the
Clarus GC

Strain Relief 
Post Support

Main P.C. Board

TB1
Wire

 
Figure 13 The location of TB1 in the Clarus 600 GC 

 
Figure 14 The location of TB1 in the Clarus 500 GC 
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RS-232 Cable

Rear of the
Clarus GC

Strain Relief 
Post Support

Main P.C. Board

TB1
Wire

 
Figure 15 View of a Clarus 600 GC TB1 with a PC cable connected 

 
Figure 16 View of a Clarus 500 GC TB1 with a PC cable connected 
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• Is the Clarus cabling properly connected as shown below? 
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Figure 17 Connections between a computer, Clarus 600 MS and Clarus 600 GC 
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Figure 18 Connections between a computer, Clarus 560 D MS and Clarus 500 GC 
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Verify sufficient carrier gas to the GC 

Before turning on the GC power, verify that the carrier gas tank contains sufficient gas 
and that the main valve is turned on. Set the tank regulator to 90 psig (621 kPa) and 
open the regulator needle valve. 

Turn on all instruments 
 

 
CAUTION 

To prevent heating the GC column before turning on the carrier gas, 
verify that the GC oven door is open before turning on the GC. 

Turn on the power switches of each instrument in the following order. 

1. Computer 

2. Printer and additional peripherals 

3. Clarus GC 

4. Mass spectrometer 

NOTE:  Wait for the Windows desktop to appear before powering on the mass spectrometer. 

Set the Clarus GC to communicate with the mass spectrometer 

Unlike the AutoSystem XL GC, the Clarus GC is automatically ready to be controlled 
by the computer.  



How to Start Clarus MS from a Cold State 

49 

Starting TurboMass 

1. To start TurboMass double-click the TurboMass desktop icon. 
The TurboMass login dialog is displayed. 

 

2. Enter the Logon Name and the Password (if any), then click OK. 
The initial TurboMass window is displayed. 

 

If GC control has not been set up, an error message appears. 
Set up TurboMass and the GC as described in the next section 
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Configuring TurboMass for GC Control 

Before you begin to use TurboMass for the first time, you must first configure it (or 
verify that it is configured) to interact with the Clarus GC. 

After establishing communication between the instruments in the system and 
creating your GC method, you can develop your TurboMass method. 

The procedure used to configure the GC depends upon whether you are initially 
configuring TurboMass for GC control or are making front panel changes to the GC.  

• Initial GC Configuration: To set up the dotLINK and GC for 
TurboMass control for the first time. 

• Reconfiguring the GC: To make front panel or hardware changes to the 
GC without changing the LINK configuration. Reconfiguration is also 
required if you add an autosampler. 

Configuring the GC for the First Time 

The following steps summarize the procedure for configuring TurboMass for GC 
control the first time: 

1. Display the top level (main) window. 

2. Select an interface. 

3. Select Configure from the GC menu. 

4. Verify the Data Acquisition port. 

5. Set the LINK Configuration Options. 

6. Set the GC Configuration Options. 
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To configure the Clarus GC: 

NOTE: This example show screen references to a Clarus 600 GC/MS system.  If you have a 
Clarus 500/560 D GC/MS system select the Clarus 500 GC. 

1. In the top-level window, Select Inlet Interface from the Configure menu. 

2. If the Clarus 600 (or if you have the Clarus 560 D GC/MS system, Clarus 
500) is not selected (highlighted), click to select it. 

3. Click OK. 
All GC commands are accessible from the GC menu in the top-level window. 
From this menu you can set up your GC configuration, develop your GC 
method, work interactively with the GC, and execute all other GC related 
procedures.  

4. From the GC menu, select Configure. 
The Configuration Editor summary window is displayed. This displays the GC 
information that will be defined during configuration. 

 
 
After configuring the GC, the area below the Configuration Editor summary 
list displays key GC information. The box on the left contains information 
about the LINK interface, which includes the type (model number), EPROM 

LINK Box 
interface 
information

Instrument 
Configuration 
information
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version number, memory size available in the interface (in bytes), and serial 
number. The box on the right contains a summary of the GC configuration. 

Summary of information displayed on the Configuration Editor window: 
 

Field Description 

Name The name of the GC. 

Type The GC model or type. 

Acq Port The physical data acquisition port to which the LINK interface is 
connected. 

LINK Port  The physical port in the LINK interface to which the GC is 
connected. 

Configured Displays YES if you provided all the information needed to 
configure the GC. Otherwise, NO is displayed. 

IPM Displays YES if the Instrument Personality Module (IPM) for the 
GC has been downloaded. The first time you open this window, 
the IPM will not have been downloaded. 

5. From the Configuration Editor window, select Configure from the Instrument 
menu. 
The serial port connected to GC dialog is displayed. 

6. Verify the serial port (in this example, COM1), LINK box connection, and 
firmware version. 

NOTE:  If the mass spectrometer and your computer were configured for COM2, then 
COM2 is your serial port. 
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7. Click on the Query Port for Type button. 
The Interface type is displayed in the box. 

 

8. Click the Continue button. 
The LINK Configuration dialog with the COM port and instrument name 
displays. 

9. Select Port A from the LINK Ports and Instruments list: 
inst1 is displayed in the box to the right of Port A. 

10. Select the Clarus 600 GC with Autosampler (or if you have the Clarus 560D MS 
system select Clarus 500 GC with Autosampler) in the Instrument Module list. 
If your Clarus 600 GC has an autosampler, select Clarus 600 GC with 
Autosampler even if you won’t be using the autosampler. You can change this 
setting from the Method Editor. 
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If you make a mistake, click Restart. This disconnects the GC and clears the 
LINK port. Clicking Reset clears all the changes to this dialog and returns it to 
the state it was in before you opened it. 
When the software verifies this connection, a box appears under Configured 
and a Configure button appears. 

 

11. In the LINK Configuration dialog, click the Configure button next to the port 
selection. 
The GC Configuration dialog is displayed. 
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12. To rename the GC to something other than its default name (inst1), enter the 
new name in the Name text box. 
This name will appear under the Name field in the Configuration Editor 
window. 

13. Click OK. 
A check mark in the LINK Configuration dialog indicates that the GC has been 
configured. 
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14. Click Finish. 
When you first configure the GC, the following message may display: 

 

15. If the GC is not turned on, turn it on now and then click Yes. 

OR 

If the GC is connected and turned on, click Yes. 
The following message is displayed: 

 

16. Click OK. 
 The following message is displayed: 

 

17. Click Yes. 
The following message is displayed: 
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18. Click Yes. 
If your Clarus GC has PPC, the following message is displayed: 

 

19. Click Yes. 
The following message is displayed: 

 

20. Click Yes.  
The following message is displayed: 

 

21. Click Yes.  
The following message is displayed: 

 

22. Click Yes.  
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The following screen is displayed: 

 

23. Select Configure from the Instrument menu. 
The following screen is displayed. 
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24. Click the Query Inst for Config button. 
The following is displayed. 

 

25. Click OK.  
The Configuration Editor window is updated and your instrument is now 
configured and the GC Configuration screen displays. 

 

26. Click Finish. 
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27. Close the Configuration Editor by selecting Exit from the File menu. 
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How to Select and Install the GC Column 

Before searching for the proper column, you must understand your sample and the type 
of analysis you are about to perform. Gas chromatography (GC) provides the means for 
separating components in a mixture by eluting the sample with a carrier gas (helium) 
over a stationary phase contained within a column. Capillary columns are used with an 
(increasing) temperature program to ensure that all of the components have been eluted 
from the column. A series of quite narrow (several seconds wide) chromatographic 
peaks emerge and can be detected by the mass spectrometer (MS). 

In a GC/MS analysis, the column is installed in the GC oven with one end connected to 
a GC injector and the other end passed through a heated interface (through the GC oven 
wall), where the column end is precisely positioned at the inner source of the mass 
spectrometer. The Clarus 600 MS uses two types of inner sources: (1) a source for 
electron ionization (EI); and, (2) a source for chemical ionization (CI).  
The Clarus 560 D only uses the electron ionization (EI) source.  The following steps 
summarize the procedure for selecting and installing the column. 

Selecting the proper column 
1. Consider the variables of a GC/MS analysis. 

2. Consider five variables when choosing a GC column. 

Installing the column 
1. Prepare the system to install the GC column. 

2. Remove an installed column. 

3. Connect one end of the new column to the GC injector. 

4. Condition the new column for use. 

5. Connect the other end of the new column to the mass spectrometer. 

6. Equilibrate the system. 
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Selecting the Proper GC Column 

Consider the following variables when performing GC/MS analyses 
 

Variable Variable Options Reason 

GC column Stationary phase 
Column length 
Column internal 
diameter 
Stationary phase film 
thickness 

Depends on the sample type, 
sample concentration, and 
complexity. 

GC injection port On-column 
Split/splitless 
Temperature 
Split/flow 

Depends on the sample 
volatility and concentration. 

GC oven temperature 
program 

Isothermal periods 
Ramp rates 

Depends on the GC column, 
and on the sample, its 
volatility and complexity. 

GC column gas 
pressure 

Isobaric or 
programmed 
Isobaric periods 
Ramp rates 

Depends on the GC column, 
and on the sample, its 
volatility and complexity. 

MS ionization mode EI 
CI+ 
CI− 

Depends on the polarity of 
the sample and its tendency 
to fragment in EI, and also 
the type of information 
required (MW only or 
structural/ library 
searchable). 
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Consider the following five variables when choosing a GC column: 

• The types of samples you will be analyzing. 

• The stationary phase of the column. 

• The internal diameter of the column. 

• The thickness of the stationary phase. 

• The column length. 

Know the types of samples you will be analyzing. Are they volatile, semi-volatile, 
pesticides, solvents, etc. Next choose a stationary phase based on polarity of the 
sample. A very general rule in column selection is that “like dissolves like.”  Column 
polarity has the greatest effect on how the column separates the compounds of interest 
as the sample interacts with the stationary phase. There are different degrees of 
polarity from non-polar to very polar. When compounds are separated primarily on 
their boiling points, the phase is considered to be non-polar. Polar phases typically 
separate compounds based on the chemical interactions between the sample 
components and the stationary phase. 

Many different types of stationary phase are available and the following list is by no 
means exhaustive. Consult recent manufacturers’ literature for the particular 
application you have in mind. 
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Stationary Phase Trade Names Sample Type 

100% dimethylpoly-
siloxane 

PE-1 MS, CPSil 5, SE 
30, OV-1, OV-101, SP 
2100, SF 96, DB 1. 

General use; including, 
hydrocarbons, 
pesticides, steroids, 
alkaloids, and 
derivatized sugars. 

5% phenyl, 95% 
methyl-polysiloxane 

PE-5MS, CPSil 8, SE 
52, SE 54, OV-73, SPB 
5, DB 5. 

Polycyclic 
hydrocarbons, di- and 
tri- glycerides, alcohols, 
fatty acids, pesticides, 
steroids, PCBs. 

polyethylene glycol CPWax 51, CPWax 57, 
Carbowax 20M, 
Carbowax 1000, SP 
1000, OV-351. 

Essential oils, fatty 
acids, flavors, esters, 
beverages, pheromones, 
alcohols, aldehydes, 
amines, acids, glycols. 

chiral Chirasil Val. Optically active isomers 

The stationary phase thickness depends on the amount of retention required. Choose 
thick films for the analysis of volatile compounds to retain them on the column for a 
longer time. Non-volatile compounds are better suited to thin films, otherwise their 
retention times will be too long. Remember, the thicker the film, the more column 
bleed one may expect. Whenever possible, always select a low-bleed column 
designed for GC/MS. 

The internal diameter of the column depends on the concentration of sample to be 
analyzed. Small diameter columns (0.25 mm i.d.) offer high efficiency and are useful 
for quantification of small amounts of sample, but are easily overloaded. Only small 
diameter columns (0.25 mm i.d. or less) may be used for the Clarus 600 S, Clarus 
600 D, and Clarus 560 D because of carrier gas flow rate requirements.  For on-
column analyses 0.32 mm i.d. columns are recommended. The smaller the i.d., the 
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lower the flow of helium gas required. The flow through a short 0.53 mm I.D. 
column may exceed the pumping capacity of some mass spectrometers. 

The column length is another consideration. In general, the more complex the sample, 
the longer the column length should be in order to retain and separate the various 
components. Typically 25 m and 30 m columns are the most suitable for general 
work. Shorter columns are used for simple separations and longer columns are used 
for the most challenging samples such as petroleum analyses and dioxin detection in 
complex matrices. 

An Example of an EPA Analysis 

There are two frequently followed EPA (environmental) methods that use very 
common columns. EPA method 625 (semi-volatile analysis) uses a non-polar column. 
The phase used is a 5% diphenyl 95% dimethylpolysiloxane (PE-5MS, RTx-5, Xti-5, 
DB-5, SPB-5). The length is 30 meters with an inside diameter of  
0.25 mm I.D. The film thickness will be from 0.25 μm to 1.00 μm. 

EPA method 624 (volatile analysis) uses an intermediate polarity column. The phase 
is a methyl cyanopropyl phenyl polysiloxane (PE-624, RTx-Volatiles, RTx-502.2, 
DB-624, VOCOL). The length can be 60, 75, or 105 meters (60 and 75 meter 
columns are the most common) depending if the GC has subambient cooling 
capability. The 105 meter column has the greatest separation power and the most 
desirable if a laboratory’s budget allows. The inside diameter of the column is  
0.53 mm I.D. with a film thickness of typically 2.0 μm or 3.0 μm. 
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Installing the GC Column 

After selecting the correct column for your analysis, your next step is to install it in 
your Clarus GC\MS system. 

The following steps summarize how to install a capillary column: 

1. Turn the injector heater and transfer line heater off and open the GC oven door. 

2. Connect the column to the capillary split/splitless (CAP), programmed 
split/splitless (PSS), or programmed on-column (POC) injector. 

3. Set the carrier gas pressure, flow rate, or linear gas velocity.  
Set the pressure for the CAP and the PSS, or the flow for the POC, using the 
optional flow readout or a flowmeter. 

4. Leak-test all new connections. 

5. Condition the column (to the manufacturers' specifications), and then connect 
the column to the mass spectrometer. 

6. Set up the Split mode or Splitless mode for a CAP or PSS injector. 

7. Pump down mass spectrometer. 

8. Leak-test all new connections. 

9. Heat the injector, transfer line, and GC column oven. 
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 Materials and Tools Required 
 

Item Part Number Quantity 

Capillary column of your choice   

1/16 inch x 0.8 mm ferrules (for 0.53 mm i.d. 
columns), or SilTite metal ferrules which give 
a better seal than graphite/Vespel, but are 
single-usage 

Graphite/Vespel 
09920107 (pkg. of 10) 

SilTite 
N9306095 (pkg. of 10) 

2 ferrules 

1/16 inch x 0.4 mm g ferrules (for 0.25 mm 
i.d. columns) 

Graphite/Vespel 
09920104 (pkg. of 10) 

SilTite 
N9306090 (starter kit) 
N9306093 (pkg. of 10) 

2 ferrules 

1/16 inch x 0.5 mm ferrules (for 0.32 mm i.d. 
columns) 

Graphite/Vespel 
09920105 (pkg. of 10) 

SilTite 
N9306094 (pkg. of 10) 

2 ferrules 

Extra SilTite nuts N9306096  

5/32 inch (4 mm) open end wrench  
(for the flat area on the transfer line) 

 1 

7/16 inch open end wrenches  2 

9/16 inch open end wrench (for the large nut 
on the transfer line) 

 1 

¼ inch open end wrenches  
(for the column nuts) 

 2 

1/16 inch column nuts 09903392 (pkg. of 5) 2 

Deactivated 0.53 mm i.d. fused silica  
(for a PSS injector) 

N6101724 1 
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Fused-silica universal connector  
(for a PSS injector) 

N9302149 1 

Powder-free, lint-free gloves N6212495 1 pr 

Scribe for cutting columns (pointed scribes are 
not recommended) 

N9301376 (pkg. of 10) 1 

Electronic leak tester  
(never use a soap solution) 

N9306085 (120 V) 
N93060+`86 (230 V) 
N9306087 (240 V) 

1 

Preparing the system to install the GC column 

Before installing the column, check that the following actions have occurred, and if 
not, perform the procedures to make them occur. If you have a diffusion pump 
system, follow the procedure under Venting a Diffusion Pump listed below. 

1. Cool the GC oven by opening the GC oven door slightly. 

2. Cool the GC injector by selecting Release Control from the top level GC menu. 

 

3. Select the appropriate injector icon on the Clarus GC touch screen. 

4. On the injector screen select the Heater Off button or check box. 

5. Display the Tune Page by clicking on  . 
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6. Ensure that the mass spectrometer is not under a vacuum by selecting 
Vent/Vacuum system off from the Options menu. 

NOTE:    Make sure to cool the source and transfer line to <100 °C before venting. 

 

7. The green light above the mass spectrometer power on/off switch should be 
flashing.  
A flashing green light above the power ON/OFF switch indicates a vented 
system. A steady green light indicates that the system is under a vacuum. 

 A turbomolecular pump takes approximately 5 minutes to slowdown and 
vent.  

Venting a Diffusion Pump 

1. Cool the transfer line and source to under 100 °C. 

2. Select Vent/Vacuum System Off from the Options menu on the Tune page, 
and confirm that you want to vent the system. 

The system will start its automatic venting sequence. The software monitors 
the temperature of the source and the inlet.  When the temperatures of both of 
the source and the inlet are less than 100 °C, the software turns off the 
diffusion pump heater and starts a 20 minute countdown timer.   
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During the cooling down period, the countdown timer will display the time 
remaining in minutes and seconds. When the count down timer reaches 0, the 
backing pump turns off. 

Once the backing pump has been turned off, the software will display a 
message indicating that the system is now cool enough to vent. The message 
also reminds you to turn off the carrier gas. 

3. Vent the mass spectrometer by pressing the push-button behind the front 
door of the mass spectrometer.  It will lock in the pressed-in position and turn 
red to indicate when the vent valve is open. 

 
 

CAUTION 
If you try to vent a hot diffusion system, oxidation of the pump oil may 
occur and cause oil to enter the analyzer tub which will damage the 
mass spectrometer. 
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The depressed push button vent switch lights when the diffusion pump cools to the 
proper temperature to allow venting. Before clicking on Pump/Vacuum System On, 
make sure the vent switch is closed (i.e., the push button is out and the light is off) 

Never vent when: 
• The diffusion pump is hot 
• During the 20 minute cool-down period 

Always check that the front panel vent button is out and the lamp is off when 
starting to pump the system down. 

NOTE: The vent valve will operate if the vent switch is pushed in (on) before the diffusion 
pump becomes hot.  This includes the first few minutes of Pump/Vacuum System On. 
 Venting during this period may cause a vacuum fault to occur and risk back 
streaming the diffusion oil into the analyzer. It is a good reminder to leave the 
instrument front door open whenever the push button switch is pushed in (on). 

NOTE: When the diffusion pump is hot, the vent switch is deactivated and will not light when 
pushed in (on). Since the vent switch may be left in the depressed position at any time, 
you should be careful to avoid closing the instrument door and forgetting that the 
push button switch is pushed in.  (When the diffusion pump cools, the pushed in push 
button switch will light and automatically vent the system). 
 

 

 
WARNING 

The GC oven and injector and the mass spectrometer transfer line can 
be hot enough to cause burns. 
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Removing an installed column 
If a column is not installed, skip this procedure. If a column is currently installed in 
your system, remove it by following this procedure. 

NOTE:  When the Source Temperature or Inlet Line Temperature is first raised after the mass 
spectrometer has been vented, there is often a pressure surge from desorbed air and 
water.  Operate should be kept off until the vacuum gauge shows this surge has passed. 

 

 
WARNING 

The transfer line is HOT and can cause burns.  
Turn off the transfer line and allow it to cool before touching it. 

1. Ensure that the system is vented as described in Preparing the system to install 
the GC column on page 74. 

2. Display the Tune Page. 
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3. Enter 20 in the GC Interface Inlet Line Temperature field on the Tune Page. 

NOTE:  The lowest value you can set is 20. ----   0 is not a valid number. 

4. Turn off the carrier gas to the column. 

5. Using two ¼ inch open-end wrenches, loosen the 1/16 inch column nut attached 
to the injector fitting and slide the column tubing completely from the injector 
and column nut. 

6. Using a ¼ inch open-end wrench and a 5/32 inch wrench over the flats on the 
transfer line, loosen the 1/16 inch column nut on the transfer line. 

7. Slide the column tubing completely from the transfer line and column nut. 

8. Remove the column from the GC oven. 

1/16-inch Column Nut

SeptumTransfer Line

1/16-inch Column Nut

Injector

Remove Column
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Figure 19 Removing a column 

9. Insert both ends of the removed column into a septum to prevent air and 
moisture damage to the column. Put the column in a safe place. 
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CAUTION 

Ensure that the column has been removed from the transfer line before 
removing the ion source. 

10. Open the mass spectrometer access door, loosen and remove the two black 
thumbscrews, hold the source by its handle, and carefully pull it straight out as 
shown in the following figure. 
 

 
CAUTION 

To prevent contamination, only hold the source by its handle. Never 
touch the part of the source that is inserted in the vacuum chamber with 
your bare fingers. 

Inner Source

Handle
Black

Thumbscrews

Access 
Door

 
Figure 20 Removing the source 
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11. Place the source on a clean surface. 
Place the handle end on a flat surface so that the source stands in an upright 
position. 

12. Close the mass spectrometer access door to keep dust from entering the 
manifold. 

NOTE:  After you are experienced with this procedure, you do not have to remove the source 
to install a column in the mass spectrometers. Refer to the alternative procedure 
described in Installing a Column Without Removing the Source on page 361.  

Connecting one end of the new column to the GC injector 
 

 
CAUTION 

To ensure that the mass spectrometer remains contamination free, wear 
lint-free gloves while connecting one end of the new column to the GC 
injector. 

For complete instructions see Chapter 6, Installing a Capillary Column, in the Clarus 
600 GC Hardware Guide (P/N 09936781) (or the Clarus 500 GC Hardware Guide  
(P/N 09936591)). The following steps summarize this procedure: 

1. Remove the current injector liner. 

2. Select an appropriate injector liner for your application. 

3. Pack the injector liner with quartz wool (depending on your analysis.) 

4. Reinstall the injector liner in the injector. 

This procedure describes how to connect a column to a capillary split/splitless (CAP) 
injector. For procedures to connect a column to a PSS or POC injector refer to 
Installing a Capillary Column in Chapter 6 of the Clarus 600 GC Hardware Guide 
(or the Clarus 500 GC Hardware Guide). 
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CAUTION 

This injector has a fragile 1/16 inch fitting. 

To preserve the integrity of the fitting: 
• Carefully tighten the nut on the fitting. 
• Do not cross-thread or overtighten the nut on the fitting. 

Allow the injector to cool before connecting a nut. 

1. Unwind about 20 cm (8 inches) from one end of the column. 

Column
20 cm

 
Figure 21 Unwinding 20 cm from the injector end 

2. Insert a high temperature septum, 1/16 inch column nut (P/N 09903392), and 
1/16 inch graphite/Vespel ferrule (0.8 mm i.d., P/N 09920107, 0.25 mm i.d., P/N 
09920104, or 0.325 mm i.d., P/N 09920105) over one end of the column. 
 

 
CAUTION 

To ensure that the mass spectrometer remains contamination free, wear 
lint-free gloves while performing this procedure.  

Do not touch the ferrule with bare fingers. Verify that the tapered end 
of the ferrule is facing toward the nut as shown below. 
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Column

1/16-inch Column Nut
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Graphite/Vespel 

Ferrule

 
Figure 22 Inserting the nut and ferrule on the column 

3. Using a wafer scribe (P/N N9301376, pkg. of 10 scribes) cut about 1 cm (3/8 
inch) from the column end. 
Break off the tubing at the score mark so that the break is clean and square. 
Examine the cut with a magnifying glass and compare it to the examples shown 
in Figure 23. 

Bad Cuts

Good Cut

 
Figure 23 Good cut and bad cuts 

4. Wipe the end of the column that with a methanol dampened lab tissue (for 
example, a Kimwipe). 

5. Locate the capillary injector fitting inside the oven. 
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1/8-inch Capillary
Injector Fitting

 
Figure 24 Location of the capillary injector in the oven 

6. Position the septum on the column as described in the following table. 
 

Injector 
Type 

Column Insertion Depth 
(measured from the back of the nut to the end of the column) 

CAP 4.4 to 5.1 cm (1 ¾ to 2 inches) 

PSS 3.8 to 4.4 cm (1 ½ to 1 ¾ inches) 

POC Flush with the septum end of the injector 

7. Insert the column into the capillary injector fitting. 
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Figure 25 Installing the column in the injector 

8. Hand-tighten the column nut ¼ turn past fingertight. 

NOTE:  Fingertight means just tight enough to hold the column in place but still allows you to 
move the column slightly if necessary to reposition it. 

9. Using two ¼ inch wrenches, tighten the column nut only until the column cannot 
be pulled out of the fitting. 
 

 
CAUTION 

Do not overtighten column nuts. Overtightening can cause damage to 
the ferrule, fitting, or column. 
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Conditioning the new column for use 
 

 
WARNING 

Explosive Hazard. Never condition your column with hydrogen gas. 
Explosive gases must always be properly vented into a fume hood. If 
your application requires hydrogen as a carrier gas, first condition the 
column with helium (99.999% purity or better). 

NOTE:  Condition the GC column before connecting it to the mass spectrometer, even if the 
manufacturer claims that the column is already conditioned. 

New columns contain volatile impurities that are carried away by the carrier gas. If 
these impurities are deposited on the ion source, you will experience decreased 
sensitivity. To correct this problem, you will have to remove and clean the ion source 
as described in Chapter 5, Maintenance, of the Clarus 600/560 GC/MS Hardware 
Guide (P/N 09936781). Conditioning a column prior to use minimizes the volatile 
impurities deposited on the source. 

To condition a column: 

1. After connecting one end of the column to the GC injector, turn on the injector 
carrier gas and allow the gas to flow through the column for three to five 
minutes. 

2. Close the GC oven door and set the GC oven temperature to the temperature 
program recommended by the column manufacturer. 

3. Condition the column for the length of time specified by the manufacturer. 
 

 
CAUTION 

Never exceed the maximum column temperature specified by the 
column manufacturer. 
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Connecting the other end of the new column to the Clarus MS 

After conditioning the GC column, connect the other end of the column to the mass 
spectrometer via the transfer line by following this procedure. 

The mass spectrometer heated transfer line prevents the sample from condensing in 
the fused-silica analytical column on its way to the ion chamber. The GC end of the 
transfer line is fitted with a Swagelok coupling and a graphite/Vespel ferrule to ensure 
a gas-tight seal between the column and the transfer line. Do not use graphite or 
stainless steel ferrules on the column. 

1. Uncoil about 50 cm (20 inches) from the new column and place the column on 
the column hanger in the oven. 

50 cm

Column

 
Figure 26 Uncoiling 50 cm from a column 

2. Slide the high temperature septum, 1/16 inch column nut (P/N 09903392), and 
1/16 inch graphite/Vespel ferrule (0.8 mm i.d., P/N 09920107, 0.25 mm i.d., P/N 
09920104, or 0.325 mm i.d., P/N 09920105) over the end of the column. 
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Figure 27 Inserting a septum, column nut and ferrule on a column 

3. Slide the septum, column nut, and ferrule along the column to the position 
shown below. 

4. Score and break 1 cm off the end of the column. Wipe the column with a 
methanol dampened lab tissue (for example, a Kimwipe). 

1 cm

Use glove.

Cut end of column
off here

Column

Slide the septum, column nut,
and ferrule to this position.

Wipe the column 
with a Kimwipe
dampened with MeOH.

1.

3.

2.

 
Figure 28 Preparing to install the column in the transfer line 
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NOTE:  When you are experienced with column replacement, refer to Installing a Column 
without Removing the Source on page 361 for an alternative procedure that shows 
how to install a column in the mass spectrometer without removing the source. 

5. Carefully insert the end of the column through the transfer line and into the mass 
spectrometer source until it is positioned midway between the hole and the wall 
on the right side of the source. 
This assures you that when you install the source, the column end is flush with 
the inner wall of the ion volume. 

NOTE:  This is a very critical step during column installation. If the end of the column is not 
precisely positioned in the ion source, decreased sensitivity can occur. 
 



Clarus 600 MS Tutorial 

 90 

Transfer Line

Insert Column into Transfer Line

2 mm or midway 
between the hole 

and the wall

Column End

Wall

Hole

Clarus 600
Gas Chro matograph

Clarus 600
Mass Sp ectrometer

 
Figure 29 Positioning the column end in the source assembly 

6. Hold the column in this position as you slide the column nut and ferrule to the 
transfer line and tighten the nut fingertight. 

NOTE:  Fingertight means just tight enough to hold the column in place but still allows you to 
move the column slightly if necessary to reposition it. 
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7. Mark the position by sliding the septum until it is flush against the rear of the 
column nut. 

1/16-inch Column Nut1/4-inch Column Nut

Septum

 
Figure 30 Marking the column position in the source 

NOTE:  Once you set the septum in the correct position on the column, be careful not to move 
it from that position. 

8. Pull the column back until the distance between the back of the nut and septum 
is about 10 cm. 
You need to pull the column back to reinstall the source in the mass 
spectrometer. If you do not pull the column back, you will break off the column 
end when you install the ion source. 
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metric
10 20 30 40 50 60 70 8

Slide the column back until the 
septum is 10 mm from nut.

1/16-inch Column Nut Septum Column

 
Figure 31 Pulling the column back to reinstall the source 

9. Position the source so it aligns with the guide pin, insert the source into the mass 
spectrometer, and secure it in place with the two black thumbscrews. 
Make sure the source is completely seated and tighten the black thumbscrews 
until they are fingertight. Do not overtighten. 
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Figure 32 Reinstalling the source 

10. Carefully slide the column into the transfer line until the septum is flush to the 
back of the column nut. 

11. To make a leak-free seal, insert a 5/32 inch wrench over the flats on the transfer 
line and with a ¼ inch wrench, tighten the column nut ¼ turn past fingertight. 
 

 
CAUTION 

This transfer line has a fragile 1/16 inch fitting. 
To preserve the integrity of the fitting: 
• Carefully tighten the nut on the fitting. 
• Do not cross-thread or overtighten the nut on the fitting. 

Allow the transfer line to cool before connecting a nut. 
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Figure 33 Repositioning the column in the ion source 

12. Start the carrier gas flowing and check for gas leaks. 

Using an electronic leak detector, start at the supply gas tank and test every 
fitting up to the injector connection inside the GC oven. 

13. Start the vacuum by selecting Pump/Vacuum System On from the Options 
menu on the Tune Page.   
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Achieving a vacuum will take 5 minutes with a 255 L/sec turbomolecular pump, 
10-15 minutes with a 75 L/sec turbomolecular pump, and 20 minutes with a 
diffusion pump. Ensure the observed vacuum is lower than 3.5 x 10-5 Torr before 
turning on the filament. 

Pumping Down a Diffusion Pump Vacuum System 
 Select Pump/Vacuum System On from the Options menu on the Tune page. 

The menu name will change from Pump/Vacuum System On to 
Vent/Vacuum System Off, the roughing pump turns on and waits for the 
system to achieve a minimum vacuum level of 3.7 x 10-1 Torr.  Once that 
vacuum level has been achieved, a relay turns on the diffusion pump heater and 
a countdown timer starts.  A typical vacuum level will stay constant until the 
count down timer reaches 10 minutes, the vacuum drops quickly to 1 x 10-4 
Torr, and continue to 4 x 10-5 Torr before the countdown timer ends. 

When the timer reaches 5 minutes, the software will enable OPERATE. If you 
attempt to use the system prior to achieving a safe operating vacuum  
(5 x 10-5 Torr), a warning message will appear. 

 
 

CAUTION 
The software will not prohibit the use of the system prior to reaching 
the desired vacuum.   The software will monitor the vacuum gauge 
pressure to determine when the system has reached the proper 
operating vacuum (5 x 10-5 Torr). 

Once OPERATE is enabled, it remains enabled unless the Vent/Vacuum 
System Off command is given. 

Monitor the vacuum and check for vacuum leaks if necessary. See How to Leak 
Check the System on page 97. 

14. Once you are confident that no leaks exist, set the injector and transfer line 
temperatures to their desired values, heat the ion source, and close the GC oven 
door to heat the column. 
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Equilibrating the system 

After installing the column, equilibrate the system for a new column by following this 
procedure. 

1. Cycle the GC through one temperature cycle. 

2. Open the oven door and using a ¼ inch wrench, tighten the column nuts slightly. 

3. Check for leaks. 
 



 

 

 

How to Leak Check 
the System 5 
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Leak Checking 

The lack of a good vacuum will severely hinder the performance of the mass 
spectrometer. To ensure that your analyses produce the expected results, it is good 
practice to Leak Check the system prior to running an analysis. 

The following steps summarize the procedure for leak checking the system. 

1. Ensure that all connections are made to the mass spectrometer. 

2. If necessary, start the TurboMass software. 

3. Display the Tune page. 

4. If necessary, start the vacuum pumps. 

5. Set the GC split flow to 50 mL/min. 

6. Display the Tune Peak list. 

7. Change the Tune Peak masses to 4, 18, 28, and 32 respectively. 

8. Ensure the proper vacuum is maintained, and then turn on the filament. 

9. If a leak exists, locate and fix it. 

Checking for leaks is actually checking the integrity of the vacuum system. You 
observe masses 4 (helium), 18 (water), 28 (nitrogen), and 32 (oxygen). 

Ensure that all connections are made to the mass spectrometer 

1. Visually inspect the system to ensure that the mass spectrometer electrical and 
gas connections are made and there are no obvious disconnections. 

2. Verify that you have carrier gas pressure to the GC. 
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Starting the TurboMass software 

1. Click the Windows Start button (at the bottom-left of the screen) and select 
TurboMass from the Programs/TurboMass path  

OR 

double-click the TurboMass desktop icon. 
The TurboMass Login dialog is displayed. 

2. Enter the Password and click OK. 
The initial TurboMass Sample List window is displayed. 
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Displaying the Tune page 

Click  to display the MS Tune window. 

Starting the vacuum pumps 

1. Select Pump/Vacuum System On from the Options menu. 

 
 
This starts the forepump and the high vacuum pump. 

2. Allow about 5 minutes for the gauge to achieve 3.0 x 10
-5

 Torr with 
1 mL/min of helium and a turbomolecular pump.  
 
Allow 20 minutes for a diffusion pump system.  
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Setting the GC split flow to 50 mL/min for the CAP or PSS injector 

If your mass spectrometer is under GC control, free it from GC control as follows. 

1. Display the top-level (main) window and select Release Control from the GC 
menu. 
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2. On the GC screen, touch Tools button and select Configuration. 
 
The Configuration screen appears. 

3. Touch the Injector button for which you which to configure the split mode. 
 
The Configure Injector screen appears. 

4. Touch the Capillary Control check box. 

 

For Split mode, select either Flow or Ratio. 

5. Touch OK. 
 
The Configuration screen appears. 

6. Touch Close. 

7. On the System Status screen, touch the Injector A button. 



Clarus 600/560 D GC/MS Tutorial 

 104 

The active method screen appears. 

 

The screen above displays the Split mode configured for Ratio. 

8. Touch the ratio field to modify the value. 
 OR 
If you configured the split mode for Flow, the following screen appears: 
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The Total Flow (split vent + septum purge + column) is displayed as a non-
editable text field.  The septum purge flow is factory preset to ~3.0 mL/min. It 
is not user adjustable.  If you set the split flow to zero, the flow display shows 
column flow plus septum purge.  Common places for leaks would be the 
septum cap, the O-ring seal, column connector, etc. See the Clarus Hardware 
Guide, Chapter 8 for further information. 

NOTE: If the displayed value is much greater than the total flow (split flow and 
septum purge + column flow), this indicates a leak in the pneumatics. 

Displaying the Tune Peak list  

 Select Peak Editor from the Options menu. 
      The Peak Editor is displayed. 

 

Changing the masses for Tune Peaks 1 through 4 to 4, 18, 28, and 32 
respectively 

1. Click in the Mass box for Tune Peak 1, enter 4 and press Enter. 

2. Click in the Mass box for Tune Peak 2, enter 18 and press Enter. 
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3. Click in the Mass box for Tune Peak 3, enter 28 and press Enter. 

4. Click in the Mass box for Tune Peak 4, enter 32 and press Enter. 

5. Enter a Span of 4 for all four Tune Peaks. 

6. Enter a Gain of 1 for all four Tune Peaks. 

7. Click in the box to the right of Multiplier, enter 400, and press Enter. 

Ensuring the proper vacuum is maintained, and turning on the filament 
 

 
CAUTION 

Filament damage may occur if you turn on the filament by clicking the 
Press for Operate button if the vacuum is above 1 x 10

-4
 Torr. 

1. Ensure the proper vacuum is maintained. 

2. Click Press for Operate to turn the filament on. 

3. Observe that mass 4 (helium) should be much larger than mass 18 (water), 
which should be larger than mass 28 (nitrogen), which should be about 4 times 
larger than mass 32 (oxygen). 

4. If necessary, increase or reduce the displayed peak size by adjusting the 
Multiplier voltage and/or entering a higher Gain number. 

OR 

Double-click in the box where the gain is displayed above the peak. 

See the following example: 
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CAUTION 

If the nitrogen (28) and oxygen (32) are larger than helium (4) and 
water (18), this indicates an air leak that could damage the filament. 
Immediately click the Press for Operate button to turn off the filament. 

Double-click here to increase 
the gain number and reduce 
the size of the peak 

Double-click here to reduce the 
gain number and increase the 
size of the peak 
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Locating and fixing any vacuum leaks 

Check for leaks around fittings and all parts of the system that are under a vacuum. 

Determining if a vacuum leak exists 

The following table indicates the types of spectra that may be generated from leaks 
in the GC/MS system.  

 

m/z 

Type of Leak 4 18 28 32 40, 44 

None (Leak free) base < 4 < 18 < 25% of 18 << 32 

Small leak base < 4 > 18 < 25% of 18 << 32 

Medium leak   > 18 > 25% of 18 << 32 

Large leak    > 18 << 32 

Very large leak    very wide  

Enormous leak 0 0 0 0 0 

All of the above ratios assume that you are using high-purity helium for your carrier 
gas. The gasses should have a 99.998% purity or higher, and the gas supply lines 
should have water and oxygen filters installed as close to the GC as possible. If a 
split/splitless (CAP) or programmed split/splitless (PSS) injector is used, the split 
vent should be opened to 50 mL/min flow of helium to prevent any air or water 
diffusing through the septum being confused with a leak. 

It is always good practice to print the background spectrum just before changing a 
tank to be sure that the new tank is not contaminated. The tank should be changed at 
about 300 psig, so there is enough left for a few days if the new tank is 
contaminated. 
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Leak-Free System 

Water at m/z 18 will be much smaller than helium at m/z 4. Nitrogen at m/z 28 will 
be smaller than water, and oxygen at m/z 32 will be < 25% of the nitrogen height. 

NOTE:  A leak-free system may not achieve these ratios for several hours if the system has 
been open to the air for some time and the air is humid. 

Small Leak 

A small leak is indicated if the nitrogen peak at m/z 28 is equal to or larger than the 
water m/z 18 peak in height, but oxygen at m/z 32 is < 25% of the nitrogen height. 
These ratios are also often observed just after the GC/MS is pumped down after 
venting. They can also occur if the MS has been under vacuum for a long time and 
the residual water has been nearly pumped away. For this reason it is a good idea to 
periodically print a copy of the background spectrum and store it in your instrument 
log book. 

Medium Leak 

If oxygen at m/z 32 is higher than 25% of the nitrogen peak at m/z 28, this indicates 
an air leak. The oxygen concentration is high enough so it begins to “cannibalize” 
the charge from the nitrogen. This leak should be fixed now. Prolonged operation in 
this condition will burn out the filament. 

Large Leak 

If oxygen at m/z 32 is higher than nitrogen at m/z 28, this indicates a significant air 
leak. The filament is now at risk of burning out. The leak must be fixed 
immediately. Keep Operate on only when necessary. 

Very Large Leak 

The leak is so large that oxygen at m/z 32 has broadened out to wider than 1 Da at 
base because of the high pressure in the MS. Water and nitrogen peaks may be small 
or absent. Turn Operate on for no longer than a few seconds at a time while trying 
to locate the leak to avoid burning out the filament. 
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Enormous Leak 

There is so much air in the MS the ions cannot traverse the distance from the ion 
source to the detector. No peaks are seen, although there may be a slight increase in 
the height of the baseline. Turn Operate off immediately. 

Locating Air Leaks 

Once determining that you have an air leak, finding the leak can be time-consuming 
and frustrating. You can save days of effort by using the correct tools. 

Necessary Tools 

• Electronic (thermal conductivity) leak detector. Never use soap solution. 

• Argon, carbon dioxide, or Freon. 

• Acetone or methanol. 

The first thing to check is the part of the system you most recently worked on. If 
nothing else has changed, this is probably the source of your leak. 

Starting at the Beginning 

Assuming you have no idea where the leak is, you need to test everything. Start at 
the tank or gas supply and work your way towards the MS. 

1. If you have a Clarus 600 GC with PPC (programmed pressure control) make 
sure the power is on and the thermal zones are cold. 
Turning the power off turns off the carrier flow, and may allow air to diffuse 
into the GC pneumatics. 

2. Check the oil level in your mechanical pump. 
The oil should be between the high and low marks on the sight glass. 

3. Check that the hose fittings on the mechanical pump are tight (do not 
overtighten). 
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4. Check that the valve on the gas supply tank is open.  

5. Check that the high-purity, stainless steel, dual-stage regulator is set to  
90 psig (6.3 kPa) and the needle valve is open. 

6. Turn on your electronic leak detector and allow it warm up. Exhale briefly into 
it to verify a negative deflection from the carbon dioxide in your breath. 
Use the leak detector to check all tank and regulator fittings. Make sure that 
you keep your fingers away from the probe - your finger oils may cause a 
positive deflection, just like helium. 

7. Work your way towards the GC, checking all fittings carefully. 

8. Check the GC injector septum. 

9. Open the GC oven door and check the injector fittings. 

10. Check any other column connections inside the oven. 

11. Set the Multiplier to 400 V and set the Gain to a value where you can see 
baseline noise at about 5%. 

12. Using a very light stream of argon (m/z 40), carbon dioxide (m/z 44), or Freon 
(m/z is usually 69 and 83, but depends on the Freon used - look up the 
spectrum in the NIST library), check the transfer line connection while 
observing the Tune page. 
 

 
CAUTION 

If you have a large or worse leak, only keep Operate on long enough to 
complete the test. Large leaks can destroy a filament. 

Argon is the best choice, if available, because it is most effective at getting in 
through small leaks. Freon is the most convenient, as it can be found in small 
spray cans at electronic and photographic stores. Make sure the Freon is a 
“zero residue” grade. 
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13. Open the front door of the mass spectrometer. Use the gas to test the O-ring by 
spraying around the front of the manifold. 

14. Remove the mass spectrometer top chassis cover. Test around the manifold top  
O-ring by spraying around the edge of the manifold lid. 

15. If you have a very bad leak, carefully spray acetone or methanol around both 
O-rings and look for an increase in pressure. 
 

 
WARNING 

Spray a small amount of acetone or methanol with extreme caution - 
both liquids are flammable. 

16. Spray gas around the brown PEEK reference gas and CI reagent gas manifold 
connections on the top of the manifold. 

17. Spray gas around the transfer line connection to the manifold. 

18. Close the Tune page and exit the TurboMass software. 

19. Replace the column with a no-hole (solid) ferrule.  

20. Restart the TurboMass software, pump-down the mass spectrometer, then Tune 
the mass spectrometer. 

21. Check the spectrum. If the leak is gone, recheck the carrier gas and the GC. 
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Advanced Leak Checking for Properly Trained Service 
Engineers 

 

 
WARNING 

There are high voltages and hot surfaces present. 

The following procedure should only be performed by a properly 
trained user or PerkinElmer Service Engineer. 

1. Remove the GC. 

2. Remove the right-hand side panel from the mass spectrometer. 

3. Spray argon or Freon gas around all flanges. 

4. Spray argon or Freon gas in the RF coil housing and around the high vacuum 
feed-throughs. 

5. Tape a plastic bag around different portions of the manifold and fill it with gas 
to attempt to locate the general area of the leak. 
 

 
CAUTION 

If not properly cooled, the turbomolecular pump will be damaged, and 
the diffusion pump will be very hot. 

The RF box will overheat if sealed off too long. 

 
 



 

 



 

 

 

How to Create a Project 
for your Analysis 6 



 

 



How to Create a Project for your Analysis 

117 

Creating a Project for your Analysis 

TurboMass groups related sets of data together into Projects. This provides you with 
the convenience of finding the data for post run analysis and for archiving data. The 
TurboMass file structure is designed with the top-level directory as the project name 
under which all data and information about that analysis are stored. TurboMass comes 
with several predefined projects, including DEFAULT.PRO, QUANTIFY.PRO, and 
TUTORIAL.PRO. All data is stored in DEFAULT.PRO until you create a new project. 

NOTE:  The Created and Modified date and time reported are taken from Microsoft 
Windows. When you import an *mdb you may see in the properties of the *.mdb file 
that the displayed Creation date is newer then the Modified date. This is because the 
Created date changes and is set to the date you imported the file where the Modified 
date remains unchanged as the date the file was last modified. 

The following steps summarize the procedure for creating a new project. 

1. Display the Sample List page and select Project Wizard from the File menu. 

2. Enter a Project name and Description. 

3. Save the settings by clicking Next. 

4. Select Create using existing project as a template. 

5. Select DEFAULT.PRO and click OK. 

6. Save the Project by clicking Finish. 
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About Project Directories 

The TurboMass data file architecture is organized around the concept of a Project. 
This is a subdirectory, with an extension of .pro, which contains several other 
subdirectories. The benefit is that keeping all of this information together makes 
archiving and backup easier. 

The subdirectories under Project are: 
 

Subdirectory Files Under the 
Data Subdirectory 

Description 

Acqudb   

*.cal
*.ipr

*.exp
*.mth

Acquisition defaults, saved tune settings, GC 
and MS methods, etc. 

Mass Calibration 
MS Tune Conditions 
MS Acquisition Methods 
GC Acquisition Methods 

CurveDB *.cdb Chromatographic calibration databases 

Data Contains the raw data files. Raw data files are subdirectories with an 
extension of .raw, which contain several other data files, as follows: 

 _expment.inf Data on the MS conditions 

 _inlet.inf Data on the GC conditions 

 _func00n.ee Temporary file used for processing 

 _func00n.dat The MS data. “n” is usually 1 , but can go up to 
32, depending on the number of data acquisition 
functions 

 _func00n.idx An index file for the MS data 
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Subdirectory Files Under the 
Data Subdirectory 

Description 

 _proc001.dat First processed data file 

 _proc001.idx An index file for the first processed data file 

 _tcfunc0.raw A Turbochrom .raw file from the first GC 
detector (if present) 

 _tcfunc1.raw A Turbochrom .raw file from the second GC 
detector (if present) 

 _functns.inf Information on the data acquisition functions 

 _header.txt A brief ASCII summary of MS conditions 

 _history.inf A short history of post-run processing 

MethDB *.mdb Chromatographic quantification methods 

 *.rme Report Method Editor files 

 *.qlm Qualitative Method files 

 *.tpl Template files 

PeakDB *.pdb Peak List data. Files of integrated peaks in 
chromatograms 

SampleDB *.spl Acquisition sequences, or “Sample Lists” 

NOTE:  The Created and Modified date and time reported (or displayed) are taken from 
Microsoft Windows. When you import an *.mdb you may see in the properties of the 
*.mdb file that the displayed Creation date is newer then the Modified date. This is 
because the Created date changes and is set to the date you imported the file where 
the Modified date remains unchanged as the date the file was last modified. 
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Creating a New Project 

1. From the File menu, select Project Wizard. 

 

The Create Project dialog is displayed. 
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2. Enter a Project name and Description. 
For this example, enter Tutorial for the Project name and TurboMass Tutorial 
for the Description. 

 
NOTE:  The project Tutorial is located in C:\TurboMass\. 

3. Save the settings by clicking Next. 
The Create Project dialog is displayed. 

 
4. Select Create using existing project as template. 

A recommended existing project to select is DEFAULT.PRO. 
Creating a project using the current project as a template or an existing project 
as a template, copies the methods and calibration files from those projects, 
leaving the data behind. This enables you to use your newly created project as 
is, or delete the files you no longer need. 
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Creating a new project creates the project with blank subdirectories. You must 
manually copy over the required information. 

5. If DEFAULT.PRO is not displayed, click Browse. 
The Select existing project dialog is displayed. 

 

6. Select DEFAULT.PRO and click OK. 
The Create Project dialog is re-displayed. 
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7. Save the project by clicking Finish. 

NOTE:  The top line of the window contains your project name (Tutorial) and the default 
Sample List (Default.spl). 
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About Tuning the Mass Spectrometer 

After determining that no leaks exist and before acquiring data, you may need to 
check the mass spectrometer tuning conditions, and if necessary, modify one or more 
of the tuning parameters. The mass spectrometer can be UltraTuned either 
automatically (Standard Tune) or manually (Custom Tune) from the Tune page. This 
procedure shows you how to tune automatically using Standard UltraTune. 

TurboMass software can automatically tune the mass spectrometer using UltraTune 
with an EI ion source. UltraTune ramps the settings for the tuning parameters until 
they are optimized for intensity, resolution, and peak shape. 

The goal of Standard UltraTune is not to give the absolute “best” tune, but one that 
will provide good library-searchable spectra with reasonable sensitivity. High or low 
concentration range samples may require you to decrease or increase the 
photomultiplier voltage for best concentration dynamic range. 
Standard UltraTune determines the optimum settings for Lens 1, Lens 2, Low Mass 
Resolution, High Mass Resolution, Ion Energy, and the Repeller. You should set the 
Ion Energy Ramp to 1.0 for a clean ion source and 3.0 for a dirty one. 

Reference Gas and Filament Control 
Since reference gas is always required for the Standard UltraTune process, the 
TurboMass software will assume control for switching the flow on and off.  

Tune History 
A tune history file is maintained that records the tune parameters following a 
successful UltraTune. It is saved in an ASCII, comma–separated format, with one 
tune record per line. The file is located in the main ‘TurboMass’ directory. Each new 
successful UltraTune will append a new line to the end of the file. 
  
If the tune history file does not exist when a record comes to be written to it, it will 
be created.  The first line of the file will contain names for each field in the record, 
which may be used as column headings when the data are imported into Excel. The 
tune history file is named “UltraTuneHistory.CSV” and it is located in the primary 
TurboMass path (C:\TurboMass\). 
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Each line (record) of the tune history contains: 

• The name of the logged–on user 

• The date the record was written to the file (format as defined in 
Regional Settings) 

• The time of day the record was written to the file (format as defined in 
Regional Settings) 

• Three sets of tune parameters (peak widths at half height and required 
peak intensity ratios). If only one set of values was generated (‘custom’ 
tune or no alternates requested for ‘standard’ tune) then the second and 
third sets will contain blank values. 

• The PMT voltages used during UltraTune. The history record will 
contain places for five values, although not all will be populated. The 
PMT voltage used for acquisition will always appear. If you specified a 
final value to be set following UltraTune (in the UltraTune Setup 
dialog) then that will appear. Alternatively, if you did not specify a final 
value to be set then up to three “optimized” values will be recorded (the 
number depends on the specific tune parameters used). 

• Set values and readbacks for the parameters not set by UltraTune (Inlet 
Line Temperature, Electron Energy, Trap Emission, Source 
Temperature, Ion Energy Ramp, and Pressure Gauge) 

• Values generated by UltraTune for Lens 1, Lens 2, Low Mass 
Resolution, High mass Resolution, Ion Energy and Repeller. 

 NOTE: If you cancel UltraTune during the data acquisition phase, the instrument will be 
restored to the state it was in prior to the start of UltraTune (i.e., previous tune 
parameters, reference gas off, etc). 

The following steps summarize the procedure for autotuning the mass spectrometer.  

1. Display the Tune Page. 

2. Start UltraTune. 

3. Setup UltraTune. 
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4. Accept the setup parameters. 

5. Start tuning TurboMass. 

6. Clear the UltraTune dialog box. 

7. Start the mass calibration process. 

8. Enter the Automatic Mass Calibration process. 

9. Start the mass calibration. 
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UltraTuning the Mass Spectrometer 

The default setup parameters for EI UltraTune are suitable for tuning with Heptacosa 
(also called FC-43, PTA, PFTBA, and heptacosatributylamine). There is no need to 
alter the Tune Mass or Peak Width parameters if you are using Heptacosa.  In a 
Standard UltraTune (intended to meet DFTPP/PFB tune criteria), you can select 
whether just the primary set of results from UltraTune will be generated or whether 
two alternate sets will also be generated.  

Before you start tuning, display the initial sample list window. 
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1. Click  to display the Tune window. 

 

2. Turn on the filament and high voltages by clicking Press for Operate at the 
bottom center of the window. 
The box to the right of Press for Operate turns green to indicate that it is on. 

3. Turn on the Reference Gas by clicking   . 
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4. Click  to start UltraTune. 
You will hear a click when the reference gas solenoid valve opens and 
UltraTune begins. The first page of UltraTune is displayed. 

 

5. Click Setup to display the UltraTune Setup dialog. 

 

The default tune parameters (Full Width Half Max (FWHM) = 0.55 for masses 
69, 131, 219, and 502) for EI UltraTune are suitable for tuning with Heptacosa. 
There is no need to alter the Tune Mass or Peak Width parameters if you are 
using Heptacosa.  

SIR sensitivity may be improved by choosing a number larger than 0.6, but 
care must be taken to avoid nearby eluting peaks with ions one m/z above or 
below the target ion. 
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6. Select your After UltraTune settings: 

Print Report - Automatically prints a tune report after a successful 
UltraTune. 

Save Alternate Tune Files - Saves the top three UltraTune result sets as tune 
files rather than just the top one. 

Prompt for Recalibration - Prompts you to perform a mass calibration after 
a successful UltraTune. 

Evacuate Reference Gas - Automatically pumps out the reference gas 
following UltraTune 

7. Set the Final Multiplier Setting. 
User Set (V) - Check this box if following UltraTune, you want to set the 
PMT voltage to the value you enter in the field. 

8. When you are satisfied with the UltraTune Setup parameters, choose OK to 
exit this dialog. 

9. Choose Start to start UltraTune and the following occurs: 
• If the source is not at the set temperature (within normal tolerance) then 

the message “Waiting for the source temperature to equilibrate” is 
displayed in the UltraTune Status dialog. 

• Once the source reaches the set temperature, if Operate is Off, Reference 
Gas is Off or Pump Out Reference Gas in On, the message “Waiting for 
Reference Gas pressure to stabilize” will be displayed.  

• If Pump Out Reference Gas is On it will be turned off, followed by a 
delay of 50 seconds. 

• If Reference Gas is Off it will be turned on, followed by a delay of 
100 seconds. The “Waiting for Reference Gas pressure to 
stabilize” message will then be removed. 

• If Operate is Off it will be turned on, followed by a delay of 5 
seconds. A check is then made to determine if the Electron Energy 
and Trap Emission current are at the set values (within ±7 and ±10 
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respectively). If either (or both) readbacks are out of tolerance the 
error message is displayed is “Electron energy not at the set 
value.” And/or “Trap emission current not at the set value” and the 
UltraTune procedure stopped. 

The UltraTune status dialog is displayed. 

The status dialog displays the part of the tuning process that is currently 
occurring. The UltraTune status bar is updated to show the progress of 
UltraTune. 

 
 
When UltraTune has finished, the UltraTune completed message is displayed. 

10. Click OK. 
The tuning parameters determined by UltraTune will be saved to the current 
tune parameter file. 

11. If the Prompt for Recalibration box was checked in the UltraTune Setup 
dialog, the following message is displayed: 

 

12. Click OK to start the mass calibration process. 
The Calibrate dialog is displayed: 
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13. Click  to start the automatic mass calibration process. 
The Automatic Calibration dialog is displayed. 

 

14. Ensure that the boxes are ticked as shown above. 

15. Click OK to start the mass calibration. 
As TurboMass calibrates, observe the Calibration Status portion of the dialog.  
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16. Upon completion the following message is displayed: 

 

17. Click OK to clear the message. 
The Save Instrument Calibration dialog is displayed. 

 
As shown above, the file will be saved in the Tutorial.PRO directory. 

18. Enter a file name for your calibration file. 
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In this example, the file is named tutorial.cal.  

 

19. Click Save to save the file. 
The Calibrate dialog is displayed. 

 

After closing the mass calibration window, if you selected Evacuate reference 
Gas in the UltraTune Setup dialog, UltraTune turns off the Reference Gas and 
the pumps out the reference gas.   

NOTE:  You can verify if it has been done by selecting Reference Gas On from 
the Gas menu to remove the check mark ( ) and selecting Pump 
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Out Reference Gas from the Gas menu and wait about one minute as the 
reference gas is pumped away. Select Pump Out Reference Gas from the 
Gas menu again to remove the check mark and stop pumping the gas. 

 

20. Select Exit from the File menu.                                                                                                                
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Developing GC/MS Methods 

The GC method is created in the GC Method Editor and it controls the GC operating 
parameters and data acquisition. For additional information, refer to Chapter 7 in the 
TurboMass Software User’s Guide. 

The MS method controls the way TurboMass scans. The MS method is created in the 
Function List Editor. Here you set up the functions that a mass spectrometer uses to 
scan during an acquisition. The function list can contain a single scanning technique, 
or a mixture of scanning techniques arranged to run sequentially or concurrently 
during an acquisition (run). For additional information, refer to Chapter 8 in the 
TurboMass Software User’s Guide. 
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Developing a GC method 
1. Select Method Editor from the GC menu. 

2. Select default.mth. 

3. Display the GC parameters by selecting Control Options from the Instrument 
menu. 

4. Set the Autosampler. 

5. Set the Oven/Inlets. 

6. Set the Carrier gas. 

7. Set the Detectors. 

8. Set the Instrument Timed Events. 

9. Save the GC method. 

Developing a MS method 
1. In sample list, right click on MS Method.  

Scan Functions window is displayed. 

2. Select MS scan or SIR from the Functions menu. 

3. Enter the method values. 

4. Enter a Solvent Delay Time. 

5. Save the MS method. 
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Developing a GC Method 

This example shows how to develop a GC method by manually injecting the test 
mix. The starting point is the Sample List window. 

 

1. Click  in the GC panel. 

 
OR 

Select Method Editor by right clicking the method name shown in the Sample 
List window for a pop-up menu, and selecting Open.  
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The Startup dialog is displayed. 

 

2. Select Load recently edited method and select Default.mth from the 
displayed path. 
For example, Default .mth is in the 
C:\TurboMass\Tutorial.pro\acqudb\default.mth path. 
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3. Click OK to display the Method Editor window. 

 

4. Display the GC parameters by selecting Control Options from the Instrument 
menu. 

 
The GC parameters are:  
Autosampler, Oven/Inlets, Carrier, Valves, Detectors, and Inst Timed Events.  

5. Select Autosampler.  
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6. On the Autosampler tab, select Manual as the Injection Source for this tutorial. 
If you are using the Clarus 600 GC (or Clarus 500 GC) autosampler to make 
the injection, select Autosampler. 

 
7. Select the Oven/Inlets tab and enter the parameters for the GC oven 

temperatures and the GC injector temperatures as shown below. 

 

The above window contains the appropriate values for this tutorial. After 
entering the values, the window visually shows you oven program temperatures. 
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8. Select the Carrier tab and set the values as shown in the following window. 

 

NOTE:  Be sure to enter the correct values in the Column and Split Control sections. 

9. If you have PPC injector parameters, enter the parameters for the GC injector 
carrier gas. 
The above window shows the appropriate values for this tutorial. 

10. After entering the values, the window visually shows you carrier gas program 
pressures. 
The above window shows that the analysis consists of the following: 

• Injector A has helium gas flowing. 
• Program time of 15 minutes for the analysis. This includes the Oven 

time and the Data end time. 
• Column Length of 20 m, Diameter of 180 μm, and Vacuum comp is On. 

For the PPC pneumatics to properly function, these values must be set 
correctly. 

• Split Control Flow of 50 mL/min. 
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11. Select the Detectors tab. If no GC detectors are installed, go to next step. 
As an example, the following window shows that an FID is installed on the GC. 

 
 
If no detectors are installed or in use, set the Gases (H2 or Air) to 0.0, the Temp 
to 0.0 and the FID Range to 0.0. 

12. Select the Instrument Timed Events tab and enter the values as shown in the 
following window. 
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These settings are for a splitless injection. They turn the split flow off just 
before the injection and then reopen the split at one minute. 

13. Click OK to display the main Method Summary window. 

 

14. Save the GC by selecting Save As from the File menu. 
The Documentation dialog is displayed. 

 

15. Enter a method description if required and click OK. 



Clarus 600/560 D GC/MS Tutorial 

 150 

The File Save As dialog is displayed. 

 

16. Enter a File name ending in .mth for your GC method, then click Save. 

17. Select Exit from the File menu. 
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Developing a MS Method 

1. Click  in the MS panel. 

OR 

Select Method Editor by right clicking the method name shown in the Sample 
List window for a pop-up menu, and selecting Open.  
The Startup dialog is displayed. 

 

2. Display the Functions dialog by selecting MS Scan from the Functions menu. 

OR 

Click on the MS Scan button. 
The Function dialog is displayed. 
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3. Enter the values shown in the following dialog and click OK. 

 
 
 

Parameter Description 

Start Mass The mass at which the scan starts. 

End Mass The mass at which the scan stops. 

Ionization Mode The mode and polarity used during the acquisition. 
This must match the type of source installed and the 
active Tune. 
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Parameter Description 

Data Specifies the type of data collected and stored on disk. 

Centroid - Stores data as centroided, intensity, and 
mass assigned peaks. Data are stored for every scan. 
This is the normal mode for GC/MS. 

Continuum - Stores data regularly to give an analog 
intensity picture of the data being acquired. Data are 
acquired continuously, even when no peaks are being 
acquired. 

Multi-Channel Analysis (MCA) - Summed continuum 
with only one intensity-accumulated scan stored to 
disk for each experiment. 

Repeats The number of repeats of a particular function. Only 
relevant for experiments having more than one 
function.  

Retention Window 
Start Time 

The retention time in minutes at which data acquisition 
starts for the scan function. 

Retention Window 
End Time 

The retention time in minutes at which TurboMass 
stops acquiring and storing data for the scan function. 

Scan Time The duration of each scan in seconds. 

Inter-Scan Delay Time in seconds between a scan finishing and the next 
scan starting. During this period data is sent from the 
MS to the computer. 
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4. Click the Solvent Delay button. 

The multiple Solvent Delay dialog appears: 

  

5. Leave the number 1 Start time at 0 and enter an End time for the solvent 
delay. Leave the remaining solvent delay lines at 0 and click OK. 

 

6. Select Save As from the File menu.  
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7. Enter a name for your file, ending with .mdb, and click Save. 

 
In this example we entered MStutorial. Notice that the name appears to the 
right of Scan Functions in the dialog header. 

8. Select Exit from the File menu. 
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Good Manual Syringe Technique 

Good manual syringe technique is fundamental to obtaining reliable and 
reproducible results, especially in quantitative work. Poor injection techniques 
account for many of the problems encountered with capillary columns.  

Consistency is perhaps the most important factor in achieving reliable results. 

The choice of syringe can affect results. For 1 or 2 microliter injections, a 5 or 10 
microliter syringe is best. For injections less than 1 microliter, a 1 microliter syringe 
should be used. 
The plunger is withdrawn only a short distance and is unlikely to be damaged during 
the injection. It is quite easy to bend a fully withdrawn plunger when making the 
injection. 

Keeping syringes clean and in good condition is also important. A common cause of 
confusing results is contamination due to sample accumulating in the syringe. 

The following injection procedure is not intended to be definitive, but should form 
the basis for the development of a consistent technique. 

Rinsing a Syringe 
Before and after an injection is made, the syringe should be rinsed as follows:  

1. Pour a few mL of solvent into a clean beaker or autosampler vial. 
2. Draw up into the barrel 4 or 5 microliters of solvent and inject it out onto a 

tissue or into another autosampler vial. 
Care should be taken when using flammable or toxic solvents. 

3. Repeat steps 1 and 2 several times. 
4. Pump the syringe with the needle remaining in the solvent. 
5. Draw up a few microliters and once again inject the solvent onto a tissue. 
6. Wipe the needle with the tissue taking care not to draw any solvent out of the 

needle by capillary action. 
This method wets the barrel of the syringe and leaves the needle full with pure 
solvent. 
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Loading a Syringe 
To load the syringe:  

1. Draw up into the syringe about 1.0 microliter of air. 

2. Draw up excess sample. 

3. Position the plunger for the required amount of sample to be injected. 
Always examine the quantity by viewing the syringe at eye level. Parallax can 
be the cause of misleading measurements. 

4. Remove the syringe needle from the sample, wipe the needle with a laboratory 
tissue and draw up the plunger until the slug of sample can be seen inside the 
syringe barrel: this action will help prevent the loss of sample through 
evaporation. 

5. Smoothly inject the needle through the septum while keeping a finger on the 
plunger to prevent blow-back. Guide the needle into the injector with a clean 
laboratory wipe (for example, a Kimwipe). Avoid touching the injector needle 
with your fingers. 

6. Fully insert the plunger and then press it firmly and quickly. 

7. Leave the needle in the injector for a few seconds. Usually five seconds is 
enough. 
If the needle is withdrawn straight after injection, then the increase in the 
pressure in the injector, due to the evaporating solvent, may cause the sample 
to blow out through the hole in the septum. 
Sometimes slow injections are required to concentrate the sample slug at the 
end of the column. Conversely, when thermally labile samples are being 
handled, a faster injection is required to prevent thermal degradation in the 
injector. Your technique should be modified accordingly. 

8. Rinse the syringe as described in Rinsing a Syringe on page 159. 

NOTE:  Cleaning is especially important when changing samples to avoid cross 
contamination. Build-up of organic material can be removed by washing the syringe 
and plunger in an ultrasonic bath. Alternatively, draw through the syringe a dilute 
chromic acid solution followed by a thorough rinse with water and then methanol 
(or other water-miscible solvent). Most syringe suppliers will advise on cleaning, 
and many offer a syringe reconditioning service. 
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Sometimes small fragments of septa lodge inside the needle and may block the bore. 
Silicone rubber may absorb some of the sample causing loss of sensitivity and cross-
contamination between samples. Needles can be cleaned out with fine wire, usually 
supplied with the syringe. 
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Split Injection 

The sample capacity of thin film 0.25 mm i.d. capillary columns is approximately 
200 ng per component before you experience GC peak distortion. Larger column 
diameters or thicker films have higher capacities.  

When operating in the split mode, only a small portion of the injected sample 
actually enters the column thus preventing column overloading. The remaining 
sample is carried out by the carrier gas through the split vent. The ratio of inlet flow 
to column flow, commonly referred to as the split ratio, ranges from 10:1 to 500:1, 
depending on the column being used and the sample being analyzed. A split of 25:1 
is common for fused silica columns. When operating in the split mode, ensure that 
the correct liner is installed in the injector. Refer to the Clarus 600 GC Hardware 
Guide (P/N 09936768) or the Clarus 500 GC Hardware Guide (P/N 09936591) for 
the procedure to set up split ratios. 

Although the technique of split injection is fairly easy to master, it does have two 
major disadvantages: 

• During trace analysis the total amount of sample is severely limited. The 
analyst cannot afford to waste most of the sample through the vent. 

• Split injection is a flash vaporization technique and there is a possibility of 
sample discrimination when injecting wide boiling range mixtures. 

• To overcome these disadvantages, splitless injection is used. 
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Splitless Injection 

The splitless injection technique allows virtually all of the sample to be concentrated 
at the head of the column, behind the condensed solvent band. In view of the 
beneficial solvent effect and much improved discrimination of wide boiling range 
mixtures, this technique is widely used in trace analysis work. 

Concentration of the sample at the head of the column is achieved by stopping the 
gas flow through the split vent. None of the sample is vented away. After a short 
interval the vent flow is restarted. In this mode larger quantities of solvent are used 
to provide the solvent effect. Component levels should be less than 50 ng to avoid 
overloading the column. 

When operating in the splitless mode: 

1. Ensure that the correct injector liner is fitted. 

2. Cool the oven to the recommended temperature for the solvent being used (see 
below). 

3. Refer to the GC method and set the valve timings such that the split valve is 
closed at injection and opens one minute later. 

4. Inject the sample. 
For large quantities, inject over a period of 5 - 10 seconds. 
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5. Start the run at the required temperature. 
 

 Recommended Initial Oven Temperatures 
Dichloromethane  10-30 °C 

Chloroform  25-50 °C 

Carbon Disulfide  10-35 °C 

Diethyl Ether 10-25 °C 

Pentane  10-25 °C 

Hexane 40-60 °C 

Iso-octane  70-90 °C 

Attention to fine detail is essential to obtain reproducible results and the following 
points should be noted: 

• The inside of the injector must be kept clean. 

• The capillary column inlet must be properly positioned in the injector. 
Refer to Start the Clarus 600 MS, or Clarus 560 D MS, from a Cold State 
on page 41. 

• The injection port temperature must be sufficient for efficient vaporization 
of the sample; 200 - 300 °C is usually adequate. 

• Solvent quantities of 1 - 3 microliters are required to obtain the solvent 
effect. 

• Initial temperature of the column should be 10 - 20 °C below the boiling 
point of the solvent to obtain the solvent effect. 

• To prevent the solvent tailing, purge the injector by opening the splitter  
60 - 100 seconds after injection with 50 to 100 mL/min split flow. 
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Building a Sample List 

Before acquiring mass chromatograms, you need to build a sample list. This is 
simply a list that links GC methods, MS methods, and autosampler vials for a 
particular analysis. Each line (row) in the list is a separate analysis. This gives you 
the ability to set up for unattended operation. 

The following steps summarize the procedure for building a sample list: 

1. Enter a unique File Name for your analysis. 

2. Select the MS Method. 

3. Select the GC Method. 

4. Enter the vial number of your sample. 

5. Select the GC injector position. 

6. Enter a sample I.D. 

7. Enter File Text. 

8. Enter a Quantify Method  

9. Enter a Calibration File 

10. Enter a Qualitative Method  

11. Enter a Report Method 

12. Save the sample list file. 

In this example we will edit an existing sample list for an analysis. You can keep the 
list simple or make it complex by adding categories as columns. 

NOTE: You can also build a sample list using the Sample List Wizard from the Samples 
menu. The Sample List Wizard is described in the Clarus  MS Environmental 
Tutorial. 
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This sample list consists of File Name, MS Method, GC Method, Vial #, Injector, 
Sample I.D., File Text. These are the only entries you need to enter. You can also 
enter a Qualitative Method, Calibration File, Quantify Method, and/or Report 
Method. 

1. Click in the File Name field and enter a unique file name. 

2. This file name becomes the subdirectory name under which all data for this 
analysis is stored. In this example, we entered Tutorial01. The subdirectory is 
c:\Turbomass\Tutorial.pro\Tutorial01.raw 

3. Select the MS Method by double-clicking in the lower right part of the  
MS Method field and selecting a mass spec method from the drop-down list. 

4. In this example, we selected MSTUTORIAL. 
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5. Select the GC Method by double-clicking in the lower right part of the  
GC Method field and selecting the GC method from the drop-down list. 

 

In this example, we selected GC tutorial.  

6. If you have a Clarus 600 GC (or Clarus 500 GC) with an autosampler, click 
Vial # and enter the number corresponding to the sample vial location in your 
GC autosampler. 
If you do not have this autosampler, this is just a text entry field. 

7. If you have a Clarus 600 GC (or Clarus 500 GC) with autosampler, enter the 
letter that corresponds to the GC Injector. Injector A is the front position and 
Injector B is the rear position. 
In this example, we selected Injector A. 

8. Enter a Sample ID. 
In this example, we entered Fid test mix. 

9. Enter File Text. 
Enter descriptive text that will be used to describe this sample.  
In this example, we entered Fid test mix C. 

10. Select the Quantify Method by double-clicking in the lower right part of the  
Quantify Method field and selecting the method from the drop-down list. 

11. Select the Calibration Curve file by double-clicking in the lower right part of 
the Calibration Curve field and selecting the file from the drop-down list. 
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12. Select the Qualitative Method by double-clicking in the lower right part of the  
Qualitative Method field and selecting the method from the drop-down list. 

13. Select the Report Method by double-clicking in the lower right part of the  
Report Method field and selecting the method from the drop-down list. 

14. Select Save As from the File menu and enter a name for this Sample List. 

15. The *.spl extension is added to the name and the file is stored in the 
TUTORIAL.PRO Project directory. 
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After the instrument has been tuned and calibrated, the GC and MS methods created, 
and the sample list built, it is time to run an analysis and acquire mass 
chromatograms of your sample. Once the mass chromatograms are acquired, you 
can perform different post-run analyses on the acquired data as discussed later in 
this tutorial. 

The following steps summarize the procedures for acquiring mass chromatograms. 

1. Display the Sample List page. 

2. Click Run. 

3. Click OK. 

4. Inject your sample and click Run. 
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Acquiring a Mass Chromatogram 

1. Display the Sample List window. 

 

2. Click Run  to display the Start Sample List Run dialog. 
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3. Click OK to start the analysis. 
When the analysis begins, notice the following actions in the sample list 
window: 

• The stop button illuminates red. 

• A green dot appears next to the number of the sample list you are running. 

• Status Information appears in the GC box. 

When both General Status and GC Status are ready, you can make an 
injection. 
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4. Press the Run key on the GC touch screen and inject 1.0uL of sample. 
Observe the status box on the bottom of this window. The Waiting for injection 
status changes to Running. 

Green dot 

Status 
information 

Status box 

Stop 
button 
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Displaying Mass Chromatograms 

While running samples, TurboMass saves the collected sample information (mass 
chromatograms) as .RAW files in the Data directory of your Project. In this 
example, the data is stored in the Tutorial Project. You can view and manipulate the 
mass chromatograms in real time during data acquisition or afterwards (post-run). 

The following steps summarize the procedures for displaying mass chromatograms: 

1. Select Chromatogram from the View menu on the Sample List window. 

2. Select Open from the File menu. 

3. Click Replace so that only one chromatogram is displayed. 

4. Select the raw chromatogram file from the Chromatogram Data Browser. 

5. Click OK. 
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Finding a Specific Mass Chromatogram 

You can open and view any mass chromatogram through the Chromatogram Data 
Browser. 

1. Select Chromatogram from the View menu on the Sample List window. 

 
 
The Chromatogram dialog is displayed. 
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2. Select Open from the File menu to display the Chromatogram Data Browser 
dialog. 

 
This example shows the three .RAW  files of the chromatograms in this 
tutorial. 

3. Select Replace, so that only one chromatogram is displayed. 

4. Select the .RAW chromatogram file from the Chromatogram Data Browser. 
In this example, we selected  the .RAW chromatogram TUT01.RAW. 

5. Click OK. 
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The chromatogram of TUT01.RAW is displayed. 

 
To view a particular peak or change the viewing area of the chromatogram, 
click and hold the left mouse button, drag it across the area, then release it. 
For additional information on displaying mass chromatograms, refer to the  
TurboMass Software User’s Guide (P/N 09936767). 
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Searching a Library to Identify Unknowns 

The following steps summarize the procedure for searching a library to identify 
unknowns. 

1. Display the mass chromatogram of the unknown. 

2. Display the unknown peak of interest. 

3. Select Combine Spectra from the Process menu to subtract out the 
background information. 

4. Perform a library search. 
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Library Searching 

1. Display the mass chromatogram of the unknown. 
Refer to How to Display Mass Chromatograms on page 177. 

2. Display the unknown peak of interest. 
Locate the peak of interest in the following window. 
 

 
 

To view a particular peak or change the viewing area of the chromatogram, 
click and hold the left mouse button, drag it horizontally, then release it.  
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For example, when you do this across the peak shown at 4.57 minutes, a 
window similar to the following appears: 

 

3. Select Combine Spectra from the Process menu to display the Combine 
Spectrum dialog. 

 
 
At about half peak height, use the right mouse button and click on one side of 
the peak and drag the mouse to the other side of the peak, then release the 
button. The selected scans appear in the Average text box. 
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Place the cursor over an area of the baseline, click and hold the right mouse 
button, and drag it over a portion of the baseline, then release it. The selected 
scans appear in the Subtract text box. 

4. Click OK. 
The following background subtracted Spectrum is displayed. 

 
 
Background subtraction removes residual background peaks and column bleed 
from the spectrum. This produces a “purified” spectrum that is more 
representative of the eluting compound. 
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5. Click   (the book button) to perform a library search. 
A window similar to the following appears with the library search results. 

 

6. You can change the library information by selecting View from the Display 
menu in the Library window. 
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A window similar to the following appears. 
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Quantification Methods 

Since Quantification is analyzing data to determine the concentration of each sample 
using an internal or external standard, you need to acquire data from more than one 
sample. The previous example in this tutorial showed how to set up and run 
TurboMass using one sample. This quantification example uses a data set of 
previously obtained data stored in the TutorialQuant Project. 

This chapter describes how to use TurboMass to perform quantitative assays. In 
Quantify you view the summary of Quantify results, calibration curves, and lists of 
integrated chromatography peaks. 

TurboMass enables you to form Quantify calibration curves using Standard samples 
containing compounds of known concentrations. The calibration curves can then be 
used to calculate the concentrations of compounds in Analyte samples. In the 
Quantify Summary window, you can view the Quantify results. For example, you 
can view the calibration curves on screen and produce a number of Quantify reports. 
You can also copy Quantify information to the Windows Clipboard so that it can be 
used by other Windows applications. 

Automated quantification provides a simple way of quantifying large numbers of 
samples within an analysis. Data can be acquired, processed, and reports printed 
without user intervention. This process is controlled from the Sample List Editor, 
which is a very important part of the Quantify system. 

The following steps summarize the procedure for building a quantification method. 

1. Create the GC method, MS method, and MS Tune. 

2. Create a sample list for this analysis. 

3. Create a Quantify method. 
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About Internal and External Standards 

Before you begin, you need to decide whether you will use internal or external 
standards for your quantitative method. This section provides information on both.  

In an internal standard method, a known and constant quantity of a compound that is 
not one of the analytes is added to the sample; this is the internal standard. The ratio 
of its retention time to the retention times of the analytes has been established. The 
ratio of its peak area to the peak areas of the analytes is determined for various 
concentrations of analytes. The unknown concentrations of the analytes in samples 
are then calculated, using the area of the internal standard peak as a reference. 
Response factors are included in the calculation to compensate for differences in the 
sensitivity of the detector to different analytes. 

Analysis by an internal standard is the preferred technique whenever practical 
because it corrects for errors in sample preparation and variations in the amount of 
sample injected. The concentrations reported for the peaks of interest are affected 
only by the quantities of the various components and the quantity of internal 
standard added. 

Internal standards should be of the same family as the target compounds (for 
example, phenols) but their retention times should generally not overlap those of the 
targets. An exception is isotopically labeled internal standards. 

In an external standard method, known amounts of analytes are run in separate 
analyses (the standard runs), and the resulting peak areas are used to obtain 
calibrated response factors. In subsequent analyses of samples with unknown 
concentrations, the concentrations of the analytes are calculated by applying the 
response factors obtained from the standard runs. 
 
Since, in an external standard method, there is no standard peak whose area changes 
with variations in injection size, the sample injection size must be reproducible from 
run to run. Therefore, external standard methods are best used with an autosampler. 
They are not recommended for manual injection. 
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Terminology 

The software and the procedures in this chapter frequently use the following words 
and expressions: 

Target compound 

Analyte: a compound whose concentration is to be determined. 

Quantification 

Quantitative analysis: determining the concentration of a target compound from 
mass spectral data. 

Internal Standard   

An internal standard is a compound that is added, in known and constant 
concentration, to the sample. The ratio of its retention time to the retention times of 
the target compounds must be established, and the ratio of its peak area to the peak 
areas of target compounds must be determined for various concentrations of the 
target compounds. The software uses this information to determine the unknown 
concentrations of the target compounds in the sample. Multiple internal standards 
may be present in a chromatogram. 

External Standard 

Known amounts of analytes are run in a separate analysis, a standard run, and the 
resulting peak areas are used to obtain calibrated response factors that are stored in a 
calibration library. In later runs, these response factors are used to calculate analyte 
concentrations.  

Response Factor Curve 

This is a plot of peak area versus concentration for a given target compound. The 
software uses response curves to compensate for differences in the sensitivity of the 
detector to different compounds. 
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Calibration 

In the Quantification software, the process of generating points on the response 
curve using scan files in which the analytes and internal standards (if any) are 
present in known concentrations. 

Calibration Library 

Calibration Library is a file that contains retention times, mass peak intensities, and 
concentrations for the internal standards, if any, and the target compounds. This file 
constitutes, in effect, a method for quantitative analysis. 
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Creating a GC and MS Method 

If you wish to run your own analysis, create and save a method to control the GC for 
your analysis, and create and save a method to control the mass spectrometer as 
described earlier in this tutorial. The method shown earlier in this tutorial was 
created specifically to analyze the mass spectrometer sensitivity test mix. You will 
need to create methods in a similar way for your own quantification analysis. 

NOTE:  The example in this tutorial assumes you have run an analysis and collected data. 
To illustrate this, we will use a sample data set in the TutorialQuant project 
containing three mass chromatograms. Proceed to Create the Quantify Method on 
page 201. 
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Creating a Sample List 

After building the GC and MS method and Tuning and calibrating, you can create a 
Sample List to perform the analysis. Earlier in this tutorial you created a simple one-
line sample list. Now you will create a multi-line sample list. These samples can be 
run (acquired) manually, but are more easily acquired automatically using the Clarus 
GC autosampler. 

1. You can customize your sample list to add the categories necessary for 
quantification. To do this select Customize Display from the Field selection in 
the Samples menu. 

 
The Customize Field Display dialog is displayed. 
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2. Select the categories to display as columns in the Sample List and click OK. 
A √  indicates a selected category. 

NOTE: You may want to save this customized display for use with other analyses. To save 
this display, select Save Format from the Samples menu and enter a name for the 
file. This file will reside under the TurboMass directory as a “xxxx.fmt” file. 
 

The Sample List Editor now has columns such as File Name, Vial # and Sample 
Type that can be filled in for each sample. Each sample is displayed as one row in 
the Sample List. The following sample list contains three samples. 
 

 

You need to tell TurboMass everything it needs to know about the samples in the list 
in order for it to perform a complete analysis. First, describe what each of the vials 
in the autosampler contains, that is, whether it contains a standard, an analyte, a 
blank or a QC sample, how to acquire it, and its concentration(s), if it is a standard. 
In addition, you must specify the name of the file in which to store the data. You 
may also want to add some management information such as Sample ID, the 
submitter’s name, or a sample description. 



Clarus 600560 D GC/MS Tutorial 

200 

Running the Samples 

As this tutorial contains previously acquired data, you do not need to run samples. 
However, if you are running an analysis of your samples using this tutorial as a 
guide, then you need to follow this procedure. 

1. Select Start from the Run menu. 
 

 
 

The Start Sample List Run dialog is 
displayed. 

 
Observe that you will Acquire Sample 
Data by running samples 1 through 3. 

 

NOTE:  Check Preview Reports to display Communiqué reports in a 
preview window prior to being printed 

2. Click OK. 
The sequence of samples begins. A green dot appears next to the line of the 
sample list that is currently running.  
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Creating the Quantify Method 

Before performing Integration or Quantification, you will create a Quantify Method 
using the Quantify method editor. By selecting a method from within the Method 
Editor this method becomes the current system method file and is used when 
performing Quantify operations. Changes made to the method are not permanent 
until they have been saved to disk. Consequently, you must save the method before 
it can be used to perform quantification by selecting Save from the File menu to 
update the current method file, or Save As from the File menu to save to a new 
method file. 

Each Sample List may have only one Quantify method. 

The Quantify method describes how a data file is processed to produce calibration 
curves and quantitative information. Details must be entered into the method for 
each of the compounds being used in the analysis. 

The Quantify Method specifies information for performing the following tasks: 

• Integration of a chromatogram trace to obtain peak information. 

• Location of the chromatogram peak relating to a specific compound from 
the list of detected peaks. 

• Calculation of a response factor for the located peak. 

• Formation of a Quantify calibration curve. 

This procedure shows you how to build a method. 

Identifying a Compound 

After running samples, TurboMass saves the collected sample information as a 
.RAW file in the Data directory of your Project. In this example, the data is stored in 
the Tutorial project. You will now select the .RAW data file and identify the 
compound from the RAW data. The first compound we will identify is dimethyl 
phthalate with a characteristic ion at 163 m/z. 
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We typically try to use the strongest, highest mass in the spectrum for quantification 
as it provides the best selectivity and sensitivity. 

1. Select Chromatogram from the View menu on the Sample List window.  

 
The Chromatogram window is displayed. 

 

2. Select Open from the File menu to display the Chromatogram Data Browser 
dialog. 

 



How to Build a Quantification Method 

203 

3. Select the .RAW chromatogram file from the Chromatogram Data Browser. 
In this example the .RAW chromatogram is TUT01.RAW. 

4. Select Replace to display only one chromatogram, then click OK. 
The Chromatogram of TUT01.RAW is displayed. 

 

5. Select Edit Method from the Quantify menu on the Sample List window.  

 

If no method currently exists, the following message is displayed: 
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6. Click OK to clear the message. 
The following Method Editor dialog is displayed. 

 

7. Display the chromatogram and expand it around the 6.18 minute  
mass 163 peak. 
Position the cursor at the 6 minute mark, press and hold the left mouse button, 
drag the mouse to the 6.35 minute mark (as indicated by a drawn line), and 
release the mouse button. 
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The following Chromatogram is displayed. 

 

8. Select Peak Annotation from the Display menu. 
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The Chromatogram Peak Annotation dialog is displayed. 

 

9. Check that the boxes are checked as shown above. If not, select the boxes to 
check them. 

10. Click OK. 
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11. Select Mass from the Display menu on the Chromatogram window. 
The Mass Chromatogram dialog is displayed. 

 

12. Make the following entries: 

• Position the cursor in the Description (m/z) text box and enter 163. 

• Select Add trace. 

• Click OK. 
The following Chromatogram is displayed. 
If necessary, expand the chromatogram around the 6.18 minute peak by 
positioning the cursor at the 6 minute mark, press and hold the left mouse 
button, drag the mouse to the 6.35 minute mark (as indicated by a drawn line), 
and release the mouse button. 
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Observe how the m/z 163 trace has much less interference and a much better 
signal-to-noise ratio, even though it sacrifices some signal intensity. 

13. From the Process menu, select Combine Spectra. 

 
 

The Combine Spectrum dialog is displayed. 
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14. Enter the Average scans. 
In the upper Chromatogram window shown below, position the cursor on the 
middle of the left side of the 163 mass peak apex, press and hold the right 
mouse button, drag the mouse across the peak (as indicated by a drawn line), 
and release the mouse button. 

 
This enters the selected scans in the Average text box in the Combine Spectrum 
dialog. 

 

15. Enter the Subtract scans. 
Put the cursor in the Subtract text box. Then in the Chromatogram window, 
position the cursor to the left of the 163 mass peak, press and hold the right 
mouse button, drag the mouse across an area above the baseline, but not across 
the peak (indicated by a drawn line), and release the mouse button. 
This enters the selected scans in the Subtract text box in the Combine Spectrum 
dialog. 
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16. Click OK. 
The following Spectrum window is displayed. 

 
 
This produces a purified spectrum of dimethyl phthalate by removing residual 
background contaminants, partially eluting peaks, and column bleed from the 
spectrum. 
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17. Arrange your windows as shown below. 

 

18. Perform a Library search on this peak by selecting Library Search from the 
Tools menu on the Spectrum window 

OR 

Click  .  
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A library search of the compound is performed and the Library window is 
displayed: 

 
 
The library search has identified this peak as dimethyl phthalate. 

19. Click the close button in the upper right corner of the window (in the Library 
dialog header) to close. 
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Entering Parameters into the Quantify Method (For 
Expert Users) 

Summary of the procedure: 

1. Open the chromatogram of the calibration run of interest. Have the method 
editor open at the same time.  

2. In the chromatogram screen, select the peak of interest and click to get the 
spectra window open.  

3. In the spectra window, double-click the mass you want to quantify on. This 
will open another chromatogram with that extracted mass of interest.  

4. Right-click and drag a retention time window in the extracted mass 
chromatogram, and notice that in the message bar it say "retention time 
window XX where XX is minutes.  

5. Then right click on the extracted ion peak of interest.  

6. Finally copy the spectrum list from the spectra window.  

7. Toggle back to the method, and observe that all the values are in the right 
place.  

8. Paste the spectrum, add the name, and append 
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Identifying and Entering the First of Three 
Compounds 

Each compound in the Sample List must be identified and entered in the Method 
Editor to properly quantify the results. This example illustrates how to enter three 
compounds. 

1. Select Edit from the Quantify Method Editor window. 
Make sure the following two items are checked in the Edit menu. If the item is 
not checked, clicking on the item displays the checkmark. 

• Propagate General Parameters. 

• Propagate Integrate Parameters. 

 
 

These selections ensure that various peak detection and integration parameters are 
used for all compounds. If these items are not checked each compound may have 
its own parameters. 
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2. Display the Method Editor dialog. 

 
 

3. Type Dimethyl phthalate in the Name text box. 
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4. Click Append. 
Dimethyl phthalate appears in the Compound list. 

   

5. Enter the Quantify Trace and chromatogram’s Retention Time values for m/z 
163 by positioning the cursor at the peak apex and clicking the right mouse 
button. 
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A line is drawn through the peak to show where the apex is selected. 
 

 
 
The Quantify Trace and Retention Time values for m/z 163 are now entered in 
the Method Editor window. 
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6. To enter the Spectrum, select Copy Spectrum List from the Edit menu on the 
Spectrum window. 

 
 
This copies all information for this spectrum. 

7. Select Paste Spectrum from the Edit menu on the Method Editor window. 
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The spectrum information is now pasted in the Method Editor with the spectrum 
in the bottom window.  

 

8. Select Conc A from the Concentration of Standards drop-down list. 

9. Click Append to save this information in the method. 
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Identifying and Entering the Next Compound 

1. Display the Chromatogram. 

 

2. Select Mass from the Display menu. 
The Mass Chromatogram dialog is displayed. 

 

3. Enter 165 for the Description (m/z) of your next peak. 

4. Select Replace trace, and click OK. 
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5. Repeat the following procedures as described for the first compound. 

• Perform Combine Spectra and Background subtract. 

• Perform a Library Search to identify the compound  
(2,4–dinitrotoluene). 

 
• Enter 2,4–dinitrotoluene in the Name text box on the Method Editor 

window. 

• All of the dinitrotoluenes generate almost identical spectra. 

• Click Append to enter 2,4–dinitrotoluene to the list of compounds. 

NOTE:  After typing 2,4–dinitrotoluene in the Name field, click Append to add this name to 
the list of compounds. Do not click Modify since this will overwrite the current entry. 

• Enter the Quantify Trace and Retention Time values for m/z 165 by 
positioning the cursor at the peak apex and clicking the right mouse 
button. 

• Copy and paste the spectrum information into the Method Editor. 

• Select Conc A. 
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Entering the Internal Standard 

 Display the Chromatogram. 

 
 
The internal standard is mass 164. 

1. Select Mass from the Display menu. 
The Mass Chromatogram dialog is displayed. 

 

2. Enter 164 for the Description (m/z) of your next peak, select Replace trace, 
and click OK. 
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3. Repeat the following procedures described above. 

• Perform Combine Spectra and Background subtract. 

• Perform a Library Search to identify the compound  
(Acenaphthene-d10). 

• Enter Acenaphthene-d10 in the Name field on the Method Editor 
window. 

NOTE:  After typing Acenaphthene-d10 in the Name field, click Append to add this name to 
the list of compounds. Do not click Modify as this will overwrite the current entry. 

• Enter the Quantify Trace and Retention Time values for m/z 163 by 
positioning the cursor at the peak apex and clicking the right mouse button. 

• Copy and paste the spectrum information into the Method Editor. 

• Select Conc B. 

• In this data set the analytes have one set of concentrations indicated by “A” 
and the Internal Standards have a different, fixed concentration indicated by 
“B” in the Sample List window. 

• Select Acenaphthene-d10 as the Internal Ref. 

• Click Append to enter Acenaphthene-d10 to the list of compounds. 

4. Select each of the two previously entered compounds, select Acenaphthene-
d10 as the Internal Ref, and click Modify after each selection. 
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5. Click General Parameters and verify that the Type is set to Internal (relative). 

6. If Type is not set to Internal (relative) select it from the drop-down list and 
click OK. 
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7. When you have entered your last compound, select Save As from the File 
menu and name the Quantify method Tutorial. 

8. Close all windows except the Sample List and proceed to Processing 
Quantification Results on page 229 to process your data. 
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Processing Quantification Results 

After acquiring your data and creating your quantification method, your next step is 
to process and view the results. This chapter shows how to process results, view 
calibration curves, and print reports. 

The following steps summarize the procedure for processing quantification results. 

1. Select Process Samples from the Quantify menu. 

2. Verify the proper Quantify Method file. 

3. Create the calibration curve file. 

4. Run Quantify. 

5. Select View Results from the Quantify menu. 

6. Select View from the Display menu to set the way you want your results 
displayed. 

7. View the integrated peak. 

8. Print the results. 
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Processing Samples 

1. Select Process Samples from the Quantify menu. 

 
The Quantify Samples dialog is displayed. 

 
 
Make sure that the proper boxes are checked, that you are quantifying the proper 
samples (for example, From Sample 1 To Sample 3), and that you are quantifying 
with the proper Method and calibration Curve. 
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2. Verify the proper Quantify Method file by clicking Browse next to the Method 
text box. 
The Select Quantify Method File dialog is displayed. 

 

The Quantify Method file in this example is Tutorial.mdb. 
If necessary, select Tutorial.mdb and click Open. 
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Calibrate the method by creating the Curve file as follows: 

1. Click Browse next to the Curve text box. 
The Select Quantify Calibration File dialog is displayed. 

 

2. Enter a unique File name. 
In this example a unique file name is tutorial.cdb. 
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3. Click Open. 
The Quantify Samples dialog is displayed. 

 

4. Click OK to quantify. 
The following dialog is displayed as the quantification process progresses. 

 

5. Select View Results from the Quantify menu. 

 
The following Quantify window is displayed. 
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6. To set the way results are displayed, select View from the Display menu. 

The Quantify Display dialog is displayed. 

 
This dialog enables you to set the way you want your results displayed. You 
can select List by Compound to show the results for all chromatograms in the 
Sample List for that compound, or List by Sample to show all of the compounds 
for that sample. 
This example shows that List by Compound was selected. 
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7. View the integrated peak by double-clicking on the compound name in the 
Summary List or double-clicking on the plotted point in the graph. 
You can interactively review the data using a view similar to the following:  

NOTE: The different windows appear and you will have to arrange them for 
your particular need as shown below. 

 
 
If the peak isn’t scaled properly, click  . 

You can also drag the small boxes at the base of the peak to perform manual 
integration of that peak. 

8. To view data for the next (or previous) peak click the toolbar button:   

(or ) 
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To modify peak data: 

1. Double-click on the compound name in the Summary window you wish to 
manually integrate. 

2. If the Edit Quantify Peak dialog is not displayed, select Chromatogram from 
the Display menu in Quantify and make sure the Show Edit Quantify Peak 
dialog is selected.  Then try step 1 again. 

 

3. Perform manual reintegration, if necessary. 

4. Click OK to accept the changes made and have the results display updated. 
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About the Qualitative Method 
A Qualitative Method defines the parameters required for generating reports that 
only optionally make use of quantitative results. You can specify a Qualitative 
Method in each row of the Sample List. The method parameters fall into two main 
categories: 

• Defining the parameters for generating a peak data set 

• Setting library search parameters 

The Qualitative Method Editor may be accessed by one of the following two ways: 

 By selecting the Qualitative Method cell in the Sample Table, right-clicking 
and choosing the Open command from the context menu. If no method name 
is specified in the cell, or if there is currently no qualitative method of that 
name in the project directory, then the Qualitative Method Editor will open in 
the ‘New Method’ state. If the cell contains the name of an existing Report 
Method then Qualitative Method Editor will open in the Edit Method state. 

 By choosing the Qualitative Method Editor command from the TurboMass 
Tools menu.  The default method will be the most recently used.  If there is 
currently no qualitative method of that name in the project directory (that is 
the METHDB subdirectory in the project hierarchy), then the Qualitative 
Method Editor will open in the New Method state. 

The Qualitative Method Editor window has three tabs; General, Search Parameters 
and Library Settings tab. Each of these tabbed sub-windows has various controls 
associated with them. 
 
The Qualitative Method is initiated and run by the TurboMass application from the 
Sample List upon completion of the sample or the Sample List. 

NOTE:  The names in the Qualitative Results may come from the Library Search results, or 
from the Quantify results (if they exist). 

Also, if a peak has both Qualitative and Quantify results, the Quantify name is used. 
The NIST Library Search results are displayed in upper case since Quantify displays 
both upper and lower case. 
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The Qualitative Process 

There can be one or two stages to the Qualitative process: 

Stage 1: Integration and peak selection: 

This is the integration of one of more defined portions of the chromatogram to 
generate a list of chromatogram peaks. This step is always carried out if a 
Qualitative Method is specified in the Sample List. The processing steps are: 

1. Integrate the chromatogram using the parameters specified in the Qualitative 
Method. 

2. Sort the peaks in retention time order. 

3. If more than one peak maximizes within ±2 scans, eliminate all but the one 
with the largest area. 

4. If ‘Exclude target compounds’ is set in the method, remove peaks that 
maximize within ±2 scans of the actual retention time of the target 
compound taken from previous quantification results. This setting is ignored 
if no quantification results are available. If this option is not checked and 
quantification results exist then these results (including compound name, 
area, height and concentration) will be associated with the appropriate peak 
in the data source. However, Area% and Norm% results will always come 
from the qualitative processing. 

5. Sort in descending area order. 

6. Eliminate all but the largest n peaks (where n is the ‘Largest peaks’ 
parameter from the qualitative method). 

7. Re–sort in retention time order. 

8. Calculate Area% and Norm% values for each peak  

9. Add the peak data to the data source. 

The output of this process will be a collection of peak data which can be 
made available to Communiqué as a data source for Qualitative Reports 
and/or used as input to the automatic library search. 
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Stage 2: Library search process: 

The library search process is the automatic library searching of the chromatographic 
peak spectra and reporting of potential ‘hits’. The n largest peaks found by the 
qualitative peak integration process described in the previous section will be library 
searched using the NIST library search algorithms.  The spectrum passed to the 
search will use the same mass defect correction as currently applied in Spectrum.  
The number of peaks to be searched, spectrum background treatment, and search 
criteria are defined by the Qualitative Method. 

 Exclude target compounds: If the Qualitative Method parameter 'Exclude 
target compounds' is selected then target compounds (that is peaks identified 
as compounds as a result of quantification) will not be in the list of n largest 
peaks. Hence they will not be library searched or available for the 
subsequent library search reports.  
 
If the Qualitative Method parameter 'Exclude target compounds' is not 
selected then target compounds will be library searched and available for the 
subsequent library search reports.  Since the target compounds will already 
have been quantified, the associated quantitative information will be 
available (e.g., Name, Area, Area%, Norm%, RT, etc). 

 

A Step-by-Step Qualitative Method Summary 
 

1. Create a Sample List 
 

2. Create a Qualitative Method 
 

3. Put the Qualitative Method in the Sample List 
 

4. Start the Analysis 
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1. Create a Sample List 
 
The first thing that you must do is to create a list of samples that you want to use to 
perform the analysis. These samples can be acquired manually, but more often they 
will be acquired automatically using an autosampler. The Sample List Editor has 
various columns such as Filename, vial or bottle Number and Sample Type that can 
be filled in for each sample. Each sample is displayed as one row in the Sample List. 
The Sample List Editor is part of the TurboMass top-level menu. 
 
You need to tell TurboMass everything that it needs to know about the samples in 
the list in order for it to perform a complete analysis. You must describe to the 
system what each of the vials in the autosampler contains, i.e., whether it contains a 
standard, an analyte, a blank or a QC sample, how to acquire it, its concentration(s), 
if it is a standard or has internal standards. In addition, you must specify the name of 
the file in which to store the data. You may also want to add some management 
information such as Sample ID, the submitter's name, or a sample description, and 
the Report Method template used.  
 

 
 
For more information on how to create a Sample List, see How to Build a Sample 
List on page 165. 
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2. Create a Qualitative Method 

A Qualitative Method is required for most Communiqué reporting (an exception is 
when you just report the chromatogram plot or acquisition conditions).  
 

NOTE: The Quantify Method is required for Calibration and Quantification curves. 
 

The Qualitative method describes how a data file is processed to produce calibration 
curves and qualitative information. Details must be entered into the method for each 
of the compounds being used in the analysis. The Qualitative Method specifies 
information for performing the following tasks: 

• Qualitative Peak integration and Reporting parameters.  

• Library Search parameters (Spectrum treatment, search type, search options 
and limits; molecular weight constraints; and reporting parameters).  

• Library Selections.  

To create a Qualitative Method, follow this procedure: 

1. Select Qualitative Method Editor from the Tools menu 
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The Qualitative Method Editor appears: 

 
 
The General parameters are needed for all qualitative reports that require a 
peak data set. Since Search Parameters and Library Settings are only 
required when a library search is to be performed, these have been placed on 
secondary tabs. 

2. Specify the chromatographic data sets which are to be subject to peak detection 
and integration. 
The options are: The full chromatogram From start To end. 
   OR 
One to four segments (Windows 1-4)  with specified start and end times. 

NOTE: Enter the peak integration parameters in the same manner as you have done in 
Chromatogram or Quantify. 

3. Enter a From value.  A blank cell indicates the chromatogram segment will 
start from the beginning of the data. The From value must be less than the To 
value (unless either is blank). 
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4. Enter a To value.  A blank cell indicates the chromatogram segment will end at 
the end of the data. The To value must be greater than the From value (unless 
either is blank). 

5. Enter a Relative height threshold (Rel Ht) of the peak in the chromatogram. 
(default is 0). 

6. Enter an Absolute height threshold (Abs Ht) of the peak in the chromatogram 
(default is 0). 

7. Enter a Relative area threshold (Rel Area) of the peak in the chromatogram 
(default is 0.0). 

8. Enter an Absolute area threshold (Abs Area) of the peak in the chromatogram 
(default is 0.0). 

9. Enter a mass (m/z)or mass function (Func) for the segment (enter TIC, a 
selected ion, or a valid mass chromatogram equation). 

10. Enter the Peak-to-peak Noise amplitude value for integration. 

11. Select the X-Axis units Time (min) or Scan. 
Time - Selects Time units for setting the ‘From’ and ‘To’ values in the grid.  
Scan - Selects Scan numbers for setting the ‘From’ and ‘To’ values in the grid. 

12. Enter the number of largest peaks you want to report. 

13. Set the 'Coelution window (sec) ±' to set a time window for peaks to maximize. 
Use this parameter to ensure reliable identification of target compounds within 
the qualitative chromatograms. Peaks identified in the quantitative results can 
be missed in the qualitative report if their retentions do not exactly match those 
found by the qualitative report method.  This can occur because two specific 
masses in a peak may maximize one or two scans away from each other (or the 
TIC) due to noise and scan-rate induced “spectral skewing”. 

14. Click on the Search Parameters tab. 
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15. Select the Spectrum Treatment to be applied to the spectrum before initiating 
the search. For example, Background Subtracted. 

16. Select the thoroughness of the search (the Spectrum search type) and its 
options. Keep in mind that more thorough searches take longer. 

17. You can select the Reverse search option to improve the matching capability 
when there are contaminant peaks in the mass spectrum. 

18. You can leave the rest of the settings as their default values or optimize as 
needed. 

19. Click the Library Settings tab. 
You may have several mass spectral libraries on your computer. Some are from 
NIST (mainlib, the main library, and replib, a smaller library of replicate 
spectra (subset of compounds, different spectra) which can improve the 
chances of finding the right compound  (Refer to the NIST2005 Software 
Manual on the NIST2005 CD). There can also be other commercial libraries 
(e.g., the Pfleger-Mauer-Weber drug library) or user-created libraries. 
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This tab allows you to select which libraries to search, and in what order.  
Restricting the number of libraries (spectra) searched increases speed in a 
linear fashion. Searching libraries which have only the target compounds with 
few "unlikely" matches also increases the chance of a correct match.  For 
example, someone doing drug analyses might search a drug library, but would 
not want to search a flavors and fragrances one. 
Compounds in mainlib (the primary NIST library) have flags indicating which 
databases they originally came from or in which industry-standard lists of 
compounds they occur. If the unknown compound is expected to be in one of 
these databases or lists, the speed and accuracy of the search can be improved 
by restricting results to members of those databases or lists. 

NOTE: If no libraries are selected, no library search will be performed. This is the default 
method for only picking Qualitative Peaks. 

 
 

20. Click Save or Save As from the File menu, then name and save the method. 
This method name will now be available in the Sample List under the 
Qualitative Method column. 
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3. Put the Qualitative Method in the Sample List 

After creating and saving a Qualitative Method, enter it in your Sample List. 

1. Display your Sample List. 

 

2. Move the slider on the bottom of the Sample List window to the right until you 
can view the Qualitative Method column. 

 

3. Double-click in the cell and select your Qualitative Method. 
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4. Start the Analysis 

Before starting an analysis save any changes made to the Sample List by selecting 
Save or Save As from the Sample List File menu. 

1. To begin acquiring data or perform post-run reporting: 

• Choose Start from the TurboMass top-level Run menu  

   OR 

• Choose   to open the Start Sample List Run dialog box. 

The Start Sample List Run dialog appears: 

 

2. Enter values or check boxes in this dialog. (The order in this dialog indicated 
the order of execution. For Example, you Acquire Sample Data, then Auto 
Process Samples, Auto Quantify Samples, perform Qualitative 
Calculations, and Generate Communiqué Reports.) 
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Project - The name of the current project appears in this text box. To acquire 
data to a different project, choose OK or Cancel exit this dialog box, open 
another project, and restart data acquisition. 

Acquire Sample Data - Selecting this option will acquire data for the specified 
samples in the list. 

Auto Process Samples - Selecting this option will process the acquired data as 
specified in the Process column of the Sample List. 

Auto Quantify Samples - Selecting this option will automatically enable 
sample quantification. 

Qualitative Calculations - Selecting this option will enable Qualitative Method 
processing  

Generate Communiqué Reports - Selecting this option will enable 
Communiqué Report generation. 

Preview Reports - Check this box to specify that the Communiqué reports 
generated during processing will be displayed in a preview window prior to 
printing (or saving to a file or database). 

NOTE:  The options above allow you to acquire and immediately process and quantify data 
as desired. Or, you may choose to process or quantify data at a later time. 

Run: From Sample n To Sample m - Sets the range of samples in the sample 
list which will be acquired/and or analyzed. If you highlight a range of rows 
before starting the analysis, the first and last rows of the highlighted region will 
be displayed here. 

Quantify, Qualify and Generate Reports: After Each Run - Indicates 
specified processing will occur after each row in the Sample List.  

At End of Sample List - Indicates specified processing will occur only after 
the sample list is complete. 

Process: Pre-Run - Specify the name of the process that will be run before the 
acquisition of the files in the Sample List. 
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Post-Run - Specify the name of the process that will be run after the 
acquisition of the files in the Sample List.  For example, to switch the 
instrument out of the operate mode and turn off various gases. 

NOTE:  If you want to run a process after each sample in the Sample List has been acquired, 
format the Sample List to display Process and enter the name of the process to be 
run for each of the samples. If you want the process to automatically operate on the 
data file that has just been acquired, select Options from the Sample List Tools 
menu, then deselect the Use Acquired File as Default parameter on the System tab. 

3. When all are entered, click OK. 
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About the Report Method Editor 

The Report Method Editor is an extension to the TurboMass software.  It enables 
you to specify a collection of report definitions (Communiqué report templates and 
related parameters) that are printed sequentially. The Report Method is a dataset that 
you can specify in each row of the Sample List.  It defines the reports to be 
generated following the analysis data or at the end of the Sample List. The Report 
Method will consist of a list of report templates and associated parameters, namely: 

• When the report will be generated (for all runs, for runs of a specific type, 
for only the last run in the sample list) 

• The output destination(s) of the report (print, save to database, save to file, 
send via email) 

• The printer (if printed) and/or the file name (if saved) 

• The email address(es) and message text (if emailed) 

• Sections of the report template to be printed or suppressed 
 

NOTE:  Only a single report method can be loaded in the Editor at a time and only a single 
instance of the Report Method Editor can be run.  If you edit a Report Method while 
the Editor is already open (e.g., by choosing the Open command from the context 
menu when the Report Method cell is selected in the sample table) then the new 
report method will replace the existing one, provided it is not in a modified state. If 
the current method is in a modified state the ‘Do you want to save the changes to 
“<report method name>”?’ warning dialog will be displayed. 
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You open the Report Method Editor in one of two ways: 

 By choosing Open from the context menu when the Report Method cell is 
selected in the Sample List. If no method name is specified in the cell, or if 
there is currently no report method of that name in the Project directory, 
then the Report Method Editor will open in the ‘New Method’ state. If the 
cell contains the name of an existing report method then Report Method 
Editor will open in the ‘Edit Method’ state.  

 By choosing the Report Method Editor command from the TurboMass 
Tools menu. The default method will be the method most recently used.  If 
there is currently no report method of that name in the project directory (that 
is the METHDB subdirectory in the project hierarchy), then the Report 
Method Editor will open in the ‘New Method’ state. 
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Selecting an Existing Template 

1. Select Report Method Editor from the Tools menu. 

 
 

The Report Method Editor screen appears: 
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2. Click the Browse button to the right of the Template field.  The Report 
Template Browser appears: 

 

3. Select a Template name and click OK (for example, click Qualitative Report). 
This now appears in the Report Method Editor dialog: 
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4. Select the Frequency of reporting. The options available are: 
• Generate report for every run 
• Generate report for every run of specified type  

Selecting this option enables a second drop-down list.  Here you select 
the type of run from the available options. 

• Generate report only for final row in the sample list 

5. Select a desired Output type. 

6. Click the Append button to add this template to the current method.  
This template appears in the Report (#/Template) field  This is a display of the 
reports defined for the current method. 
When the list is empty (New Method, after Clear List or after all reports have 
been Deleted) the controls on the right will be set to default values. In this way 
the Append button is always enabled and valid. 
Using the Move Up and Move Down command buttons reorders the Reports in 
the list. Reports will be processed by report number (i.e., in the order in the list). 

7. Select Save As from the Report Method Editor File menu. 
The Save Report Method As dialog appears: 

 

8. Type a File name for your Report Method (for example, Qualitative Report) 
then click Save. 
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This Report Method is now available for the Report Method column of the 
Sample List. 

9. Double-click in the Report Method field and select Qualitative Method from 
the drop-down list. 

 

10. Close the Report Method Editor by clicking the Close box (in the upper-right 
hand corner of the screen). 
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About the Report Method Editor 
In this section we will show you how to use the Report Method Editor and 
Communiqué to modify an existing report template and create a new report 
template.  

A vital aspect to the flexible reporting capabilities of the TurboMass software will 
be the data model.  This defines the data that will be made available to Communiqué 
for design of the template and generation of the report. Most TurboMass data is 
available through the data model.  This includes: 

• All existing quantitative data generated by the TurboMass Quantification 
process (including Area% and Norm% values). 

• The chromatograms and spectra defined by the Qualitative method and its 
processing. 

• Values associated with the multiple ion ratio identification process (ratios, 
pass/fail, etc.) 

• Peak plots associated with multiple ion ratio processing (for target 
compounds and internal standards). 

• Calibration curve plots associated with target compounds. 
• Library search spectral plot data and text results. 
• Quantification and Qualitative method parameters. 

TurboMass creates a collection of Data Objects that appear in the Communiqué 
Report Creator. 

 

In the Communiqué Report Creator, note that collections  (in the Communiqué 
sense of the word) are indicated by parentheses ‘( )’ following the collection name 
for example Samples( ). 
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Modifying a Report Template 

To modify an existing report template, follow this procedure: 

1. Select Report Method Editor from the Tools menu. 

 

The Report Method Editor screen appears: 

 

2. Click the Browse button to the right of the Template field.  The Report 
Template Browser appears: 
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3. Select a template name and click OK (For example, click Qualitative Report). 
This now appears in the Report Method Editor dialog: 

 

4. Click the Edit button. 
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This launches the Communique Report Creator. 

 

Add a Graphic to the Template 

To add a graphic to the template, follow this procedure: 

1. Click Graphic in the Layout Tools toolbox. 
A dialog similar to the following appears: 
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2. Browse to the directory where the graphic is stored and select it by clicking on 
it. 

3. Move your cursor to the design page and click.  The cursor changes to the 
following cursor: 

 

4. Move your cursor to a desired spot on the page. Click the left mouse button, 
drag the mouse to scale the graphic to a desired size, then release the mouse 
button. 
The graphic appears on the page. 
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Adding a Data Object to the Template 

To add a data object to the template, follow this procedure: 

1. Click on Data Objects to display the available data objects. 
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2. Move the table (see above) and then the Chromatogram Plot down the page to 
make room at the top of the Chromatogram Plot.  

To move the table and Chromatogram Plot, move your cursor over the table.  

It turns into .          Now hold the left mouse button down and move your mouse 
to move the table.  
Next move the Chromatogram Plot the same way. 
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3. Click on Project Name, move your cursor to the designer page, the click 
where you want the Project Name to appear and drag it to the desired size. 

4. Click on Layout Tools to display the Layout Tool selections, click on Text 
Block, move your cursor to a position on the designer page, click and drag to 
put the text block on the page.  Position the cursor on an edge of the Text 
Block and hold the left mouse button down and drag the edge to the proper 
size. 

5. Click in the Text Block and type (for example, Project Name). 

6. Highlight the text and right click to display the text formatting options. 
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7. Click Save As from the File menu, name and save your file. 

8. Exit the Report Designer. 
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Creating a New Report Template 

To create a new report template, follow this procedure: 

1. Select Report Method Editor from the Tools menu. 

 

The Report Method Editor screen appears: 

 

2. Click the New button to the right of the Template field. The Communiqué 
Report Creator appears: 
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3. Click on Header in the Layout toolbox on the left of your screen.  
The Header appears: 

 

If you click on New Template the template description will be displayed.  
Here you can allow for A4/Letter resizing of your template. To properly 
use the non-A4 templates as the only set, the Allow A4/Letter page 
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resizing option in each template's description page should be selected. In 
all cases the Paper drop-down list on the template description page 
should always be set to Letter so that the page size appears properly in 
the template editor. 

 

4. Drag a Text Block into the Header.  Label it “Qualitative Report Test1.” Then 
format the text as follows: 

• Highlight text and right-click to select Format. 

• Select Font tab. 

• Set to Blue, 20 pt. Ariel, Bold. 

• Set Paragraph tab, alignment Horizontal/Center. 
• Click OK. 

• Resize the Text Block so that you can see the text. 

5. Click on Footer in the Layout toolbox on the left of your screen.  The footer 
appears. 

6. From the Data Objects toolbox, left click DateTimeReport. 
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7. Click in the footer, then size Date Time Report into the Footer to full width. 
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8. Click on Page Type 1 in the Layout toolbox on the left of the screen. This will 
display the main body of the template. 

9. Click on Chromatogram (Active X) in the Project > Samples()  directory of 
the Data Objects toolbox (Graphic Data Objects have a small red “x” as their 
icon. 
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10. Left-click on Chromatogram (ActiveX), move the cursor to the center of the 
design page, then left click and hold the mouse as you drag the mouse to 
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expand the box. The box displays as CHROMATOGRAM PLOT GRAPH 
HEADER. 

 
 

11. From Layout Tools, left click on Table then move your cursor to the page and 
left click.  A four column by two row table appears. 

12. Select the table. Right-click Format. 
The Format Table dialog appears: 
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13. Change the Number of columns from 4 to 5 then click OK.  If necessary, click 
on the Columns tab and change the Column width to 0.5. 

14. Add text blocks to the top row of the table.  Label each cell as follows;  #, RT, 
Name, Match Factor, and Area%.   

NOTE:  Remember to first put a Text Block (from the Layout Tools) in the table so that you 
can enter a label.  

 

15. Under “#” put Peak Number, from the Project / Samples() / Qualitative Peaks 
() path in the Data Objects toolbox. 

  
If you move your cursor over Peak Number (DATA) the following appears: 

 
This information Project.Samples(Current).QualPeaks(Current).PeakNumber is 
the source string of the data. In this example, it will report the peak number of 
the current QualPeak in the current Sample.   
About Samples; Current versus Last:  The template is used to pull 
information from the data source during report creation. From the point of view 
of the data source, the most recent data (e.g., the current line on the Sample 
List) is the last data entered into the data source. Therefore, to view data from 
the current line of the Sample List, use Samples(Last).  
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To report the most recent line in the Sample List we need to change the 
Indexing of the Peak Number. Right click on Peak Number (DATA) and select 
Indexing from the menu. 
The Data Object Indexing dialog appears: 

 
Double click on Current in the Samples Index cell. 
The following Index dropdown menu appears: 

 
Select Last then click OK.  

16. Under “RT” put Retention Time, from the Project / Samples() / Qualitative 
Peaks () path in the Data Objects toolbox. Set to Samples (Last). 
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17. Under “Name” put Name, from the Project / Samples() / Qualitative Peaks () 
path in the Data Objects toolbox. Set to Samples (Last). 

18. Under “Match Factor” put Match Factor, from the Project / Samples() / 
Qualitative Peaks () / Text Hits /  path in the Data Objects toolbox. Set to 
Samples (Last). 

19. Under “Area%” put Area%, from the Project / Samples() / Qualitative Peaks () 
/ path in the Data Objects toolbox. Set to Samples (Last). 

20. Check your Date/Time Data Object Properties for the correct Time Format.   

 

The default Communiqué setting for Date/Time Data Objects is "Local time." 
In order to ensure that the correct time is reported on your computer, right-click 
the Date/Time Object in your template, select Object Properties from the pop-
up menu and in the following dialog select "Original time" to set the Time 
Format, then click OK. 

NOTE:  When setting the Numeric Data Object Properties in your Communique template, 
increase the number of significant figures from the default of 4 to 6 in order to see 
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the reported number with no rounding applied. Otherwise Communiqué does not 
report 6 figures but instead applies rounding. 

21. Select Save from the Communiqué Report Creator File menu and name the file 
(for example, Mod Qualitative Report). 

 

22. Close Communiqué Report Creator by clicking Exit from the File menu. 
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Select the Template in the Report Method Editor 

After closing the Communiqué Report Creator the Report Method Editor 
appears: 

 

1. Click the Browse button. 
The following dialog appears: 
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2. Select your template (for example, Qualitative Report) and click OK. 
Qualitative Report appears as shown below: 

 

3. Click the Append button. 
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This template appears in the Report (#/Template) field  This is a display of the 
reports defined for the current method. 

 

When the list is empty (New Method, after Clear List or after all reports have 
been Deleted) the controls on the right will be set to default values. In this way 
the Append button is always enabled and valid. 
Using the Move Up and Move Down command buttons reorders the Reports in 
the list. Reports will be processed by report number (i.e., in the order in the list). 

4. Set the other options on this screen. For example, set the Frequency to one of 
the following: 

 Generate report for every run. 
 Generate report for every run of specified type. (Analyte, Blank, QC, 

or Standard) 
 Generate report only for final row in the sample list. 

5. Set the Output options and specify a Report name prefix if it is required by the 
Output type selected. (For example, if you select Save to file, select a Report 
name prefix of <Sample Name>, and click the Setup button.  
The following dialog appears: 
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6. Click OK.  

7. Select Save As from the Report Method Editor File menu. 
The Save Report Method As dialog appears: 

 

8. Type a File name for your Report Method (for example, Qualitative Report) 
then click Save. 
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This Report Method is now available for the Report Method column of the 
Sample List. 

9. Double-click in the Report Method field and select Qualitative Method from 
the drop-down list. 

 

10. Close the Report Method Editor by clicking the Close box (in the upper-right 
hand corner of the screen). 
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Shutting Down Clarus MS 

There are two types of shutdown procedures: 

• Turning off the filament (and, if in the CI mode, the reagent gases) 

• Turning off the mass spectrometer  vacuum (usually for a long-term 
shutdown) 

You can shut down Clarus MS either manually or automatically. 

Manual shutdown is simply turning off the filament. TurboMass also features a user-
settable shutdown function that automatically shuts down Clarus MS after it 
completes the analysis defined in the Sample List. The shutdown process works as 
follows: 

1. TurboMass turns off the filament and switches to the Standby mode. 

2. The Autoshutdown Tune file opens and applies its parameters. 

The following steps summarize the procedure for shutting down the 
Clarus MS: 

1. Determine if you want to manually or automatically shut down Clarus MS. 

2. Determine the type of shutdown you wish to accomplish: overnight, weekend, or 
long term. 

3. If automatically shutting down Clarus MS, create the shutdown file. 
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Types of Shutdown 

Overnight 

This is the most commonly used shutdown procedure. 

1. Turn off the filament by selecting Shutdown from the Run menu on the Sample 
List window. 

  

2. Check the MS section of the Sample List window and ensure the Operate light 
is off. 
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This ensures that the filament is off. 
If the Operate or Filament lights are on (green), display the Tune page and 
turn Operate off. 

3. If you are using a split/splitless injector, turn off the split flow or set it to below 
10 mL/min. 
Turning off the splitter conserves carrier gas. 

 

If TurboMass is under GC control, free it from GC control as follows: 

For PPC Pneumatics 

1. Select Release Control from the top-level GC menu. 

 

2. Touch the Tools button and select Configuration. 
 
The Configuration screen appears. 

3. Touch the Injector button for which you which to configure the split mode. 
 
The Configure Injector screen appears. 

4. Touch the Capillary Control check box. 
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For the Split mode select either Flow or Ratio. 

5. Touch OK.  The Configuration screen appears. 

6. Touch Close. 

7. On the System Status screen, touch the Injector button. 

The active method screen appears. 
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The screen above displays the Split mode configured for Ratio. 

8. Touch the ratio field to modify the value. 

OR 

If you configured the split mode for Flow, the following screen appears: 
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The Total Flow (split vent + septum purge + column) is displayed as a non-
editable text field.  The septum purge flow is factory preset to ~3.0 mL/min. It 
is not user adjustable.  If you set the split flow to zero, the flow display shows 
column flow plus septum purge.  Common places for leaks would be the 
septum cap, the O-ring seal, column connector, etc. See the Clarus Hardware 
Guide, Chapter 8 for further information. 

NOTE:  If the displayed value is much greater than the total flow (split flow and septum 
purge + column flow), this indicates a leak in the pneumatics. 

For non-PPC Pneumatics 

1. Click    to display the Acquisition Control Panel dialog. 

2. Select Hands On from the top-level GC menu.  

 
The GC hands on dialog is displayed. 

3. Change the appropriate split valve to OFF. 

4. Click Set valves. 

5. Click Close. 

6. Turn off your computer monitor to prevent burning the display into the screen. 
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Weekend 

1. Perform the Overnight shutdown procedures. 

2. Turn off the GC oven heater by slightly opening the oven door. 

Long-Term 

1. Perform the Overnight and Weekend shutdown procedures. 

2. Vent the vacuum system. 

Venting the Turbomolecular Pump Vacuum System) 

1. Cool the source and inlet to below 100 °C. 

2. Select Vent/Vacuum System Off from the Options menu on the Tune 
page, and confirm that you want to vent the system. 

Venting the Diffusion Pump Vacuum System 

1. Cool the transfer line and source to under 100 °C. 

2. Select Vent/Vacuum System Off from the Options menu on the Tune 
page, and confirm that you want to vent the system. 

The system will start its automatic venting sequence. The software 
monitors the temperature of the source and the inlet.  When the 
temperatures of both of the source and the inlet are less than 100 °C, the 
software turns off the diffusion pump heater and starts a 20 minute 
countdown timer.   

During the cooling down period, the countdown timer will display the 
time remaining in minutes and seconds. When the count down timer 
reaches 0, the backing pump turns off. 

Once the backing pump has been turned off, the software will display a 
message indicating that the system is now cool enough to vent. The 
message also reminds you to turn off the carrier gas. 
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3. Vent the mass spectrometer by pressing the push-button behind the 
front door of the mass spectrometer.  It will lock in the pressed-in 
position and turn red indicating the vent valve is open. 

 
 

CAUTION 
If you try to vent a hot diffusion system, oxidation of the pump oil may 
occur and cause oil to enter the analyzer tub which will damage the 
mass spectrometer. 

 

The depressed push button vent switch lights when the diffusion pump cools to the 
proper temperature to allow venting. Before clicking on Pump/Vacuum System On, 
make sure the vent switch is closed (i.e., the push button is out and the light is off) 

Never vent when: 
• The diffusion pump is hot 
• During the 20 minute cool-down period 

Always check that the front panel vent button is out and the lamp is off when 
starting to pump the system down. 
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NOTE: The vent valve will operate if the vent switch is pushed in (on) before the 
diffusion pump becomes hot.  This includes the first few minutes of 
Pump/Vacuum System On.  Venting during this period may cause a 
vacuum fault to occur and risk back streaming the diffusion oil into the 
analyzer. It is a good reminder to leave the instrument front door open 
whenever the push button switch is pushed in (on). 

NOTE: When the diffusion pump is hot, the vent switch is deactivated and will not 
light when pushed in (on). Since the vent switch may be left in the depressed 
position at any time, you should be careful to avoid closing the instrument 
door and forgetting that the push button switch is pushed in.  (When the 
diffusion pump cools, the pushed in push button switch will light and 
automatically vent the system). 

3. Turn off the GC gases. 

4. Close the TurboMass software and the Microsoft software. 

5. Turn off the GC, TurboMass, and computer. 
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Automatic Shutdown 

Automatic shutdown turns off the filament (and, if running CI, the reagent gases) at 
the end of a run (batch). For additional information about Automatic Shutdown, 
refer to the TurboMass Software User’s Guide). 

Turning off the Filament 

1. Select Edit Shutdown from the Run menu 

 

The following Shutdown dialog is displayed. 

 

2. Select Enable Shutdown after batch and enter a time in minutes. 
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3. Select Save from the File menu. 

4. Select Exit from the File menu to close this window. 

Auto Control Tasks 

1. Select Edit Shutdown from the Run menu.  

 

The following dialog is displayed. 

 

2. Select Open from the File menu in the Shutdown dialog. 
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The StartUp and ShutDown tasks for the EI and CI modes are displayed. 

 

3. Select a file and click Open. 
This loads the selected StartUp or ShutDown file. In this example, 
ShutDownEI.acl was selected. 
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4. Select the Auto Control Tasks tab and observe the Control Tasks. 

 
 

 
CAUTION 

Do not edit the contents of these lists unless you have thoroughly read 
the TurboMass Software Guide and understand how the control tasks 
function. 

5. Select Exit from the File menu. 
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Chemical Ionization 

Chemical Ionization (CI) uses an inner ionization source different from that of 
electron ionization (EI). The primary difference is that the CI source does not have 
repeller and trap electrodes. This is because when the electron beam is emitted from 
the filament, very few electrons are likely to reach the trap (due to the high source 
pressure). The filament current is therefore regulated using the total emission current 
(the source current).  

Also, the electron entrance and ion exit apertures in the CI source are smaller to 
restrict gas flow and maximize the pressure inside the ion volume. When a reagent 
gas such as methane, iso-butane, or ammonia is introduced into the ion chamber of 
the source, it is bombarded with the electron beam thereby producing reagent gas 
ions. By producing a higher source pressure (than EI) in the CI ion chamber, 
reactions occur where these ions lead to the protonation of the sample. In CI+ the 
MH+ sample ions are usually detected, and in CI-negative sample ions are detected, 
for example M-.. 

The following steps summarize the procedures for setting up and running Chemical 
Ionization. 

1. Connect the CI reagent gas. 

2. Leak check. 

3. Tune for EI. 

4. Set the CI parameters. 

5. Adjust the CI reagent gas. 
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About the EI and CI Inner Ion Sources 

The mass spectrometer EI ion source works on the principle of electron ionization, 
whereby a heated filament produces a beam of electrons as shown in Figure 34. The 
electrons are directed at the electron trap that is held in the ion block. This process is 
helped by focusing (or collimating) using a pair of attracting magnets. Any vaporized 
sample molecules in the ion block are liable to collide with the energetic electrons 
and be ionized. The sample ions are repelled out of the ion block through the lens 
assembly towards the m/z analyzer by the ion repeller, which runs typically at a 
voltage of   0 to 1 V. The source is heated by a heater in the ion block. 

Filament

Electrons

Lens

Analytical Quads

Sample
Molecules

Electron
Trap

Ion
Repeller

 
Figure 34 EI Ion Source 

Before analyzing samples, the source should be tuned and calibrated by 
continuously passing an appropriate reference material (through the reference gas 
inlet) into the source as you tune and calibrate.  
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The mass spectrometer UltraTunes in the EI mode, but does not UltraTune in the CI 
mode. To set up the mass spectrometer for CI, perform UltraTune in the EI mode 
with the EI inner source. After Tuning vent the system, remove the EI inner source, 
install the CI inner source, and optimize the tuning parameters for CI operation. 
Then inject a known sample through the GC column to evaluate the GC/MS 
performance and sensitivity. The following table lists the suitable reference and test 
materials. 

 

Ionization Reference Material Reference File GC Test Compound 

EI Heptacosa Hepta.ref octafluoronaphthalene  
or hexachlorobenzene 

CI+ (n.b. use EI calibration) benzophenone 

CI- Heptacosa HeptaNeg.ref octafluoronaphthalene 
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Typical EI Parameters 

The following table lists the typical EI parameters: 
  

Parameter EI Value and Comments 

ion energy For example, 0.5 to 1.5 
(set ion energy with a low repeller and set repeller later.) 

trap emission 50 to 200 μA (leave as low as possible.) 

Repeller 0 to 1.5 V (keep as low as possible.) 

resolution (LM/HM) For example, 10/12; varies with the mass spectrometer; 
(need a minimum 50% valley between 12C/13C isotopes.) 

multiplier 220 V to 600 V 

source temperature 150 to 220 ºC 
(lower temperatures minimize fragmentation.) 

filament current 2.5 A to 4.0 A 

source current Twice the emission current or higher. 

NOTE:  If the trap is dirty or the filament misaligned, the source current will read high, 
while at the same time the trap current will read low. 
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Sample ion beam stability is related to electron current stability and so for electron 
ionization (EI) the source is trap (emission current) regulated, at a level of 50 to 200 μA. 
This usually requires a filament current of 2.5 to 4.0 A. If the filament is operating any 
higher than this value, it is likely to burn out. The electrons that do not reach the trap are 
monitored as the source current, and the “source: emission” current ratio is also critical. 
A ratio of 3 : 1 or less is appropriate, and implies that the filament is correctly aligned 
and the source is clean. A ratio of above 3:1 indicates that the source requires cleaning 
or that the filament is misaligned. 

NOTE:  If the inner source is clean, the repeller reading will be close to zero. When the 
source is becoming dirty, a higher repeller voltage is required to force the ions out 
of the source. The inner source should be cleaned when 4 or 5 volts is required. 
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Changing from EI to CI Mode 

Changing modes consists of the following:  

• Connecting the CI gas. 

• Changing the source and instrument control mode. 

• Leak-checking. 

• Setting-up CI. 

Connecting the CI Gas 
 

 
WARNING 

Hazardous gas vapors. When using ammonia gas when running in the 
chemical ionization (CI) mode, it is necessary to vent the mass 
spectrometer effluent from the forepump exhaust into a fume hood or 
charcoal trap. 

 

 
WARNING 

Explosive Hazard. If the hydrogen, methane or iso-butane is turned on 
without a column attached to the injector and/or detector fittings inside 
the oven, the gas could diffuse into the oven creating the possibility of 
an explosion. 

If the mass spectrometer is not under vacuum, hydrogen, methane or 
iso-butane can fill the vacuum chamber thereby creating an explosive 
hazard. 

To avoid possible injury, do not turn on the hydrogen, methane or iso-
butene unless a column is attached, all joints have been leak-tested, and 
the mass spectrometer is under vacuum with the forepump exhaust 
properly vented to a fume hood. 
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Recommended Gases  

Reagent gases used in chemical ionization (CI) are ammonia, and the hydrocarbon 
gases methane and iso-butane at 99.95 % or better purity. 

The gas delivery pressure required is 15 psi to the bulkhead fitting on the back of 
mass spectrometer. A two-stage stainless steel diaphragm, high purity regulator is 
required with a final delivery pressure of 15 psi. A single-stage stainless steel 
diaphragm, high purity, rated for erosive service is required for ammonia. Clean 
tubing must be used. It must be solvent-washed and nitrogen-dried. The bulkhead 
connector at the rear of the instrument is a 1/8 inch Swagelok fitting. 

 

 
WARNING 

If ammonia is used for chemical ionization, all fittings and tubing must 
be stainless steel to avoid corrosion. Also, the forepump must be vented 
to a fume hood or trap. 

To prepare the mass spectrometer for CI: 

 Obtain the CI gas cylinder for your analysis. 

 Connect the gas line to the CI Gas connector on the rear of the mass 
spectrometer. 

 Ensure that mass spectrometer is at the proper vacuum level. 

 Turn on the CI gas and set the delivery pressure to 15 psi (104 kPa). 

 Leak-check all connections. 
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Figure 35 CI Gas connection on the rear panel of the Clarus 600  

Changing to CI 

To change from the EI to the CI mode: 

1. Remove the EI inner source by following the procedure described in this 
tutorial. 

2. Properly cover and protect the EI source and put it in a safe place. 

3. Install the CI source by following the procedure described in this tutorial. 

4. Select CI+ from the Ion Mode menu. 
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5. Select Pump/Vacuum System On from the Options menu. 
This starts the forepump and the turbomolecular pump. 

6. In the Vacuum Pressure Gauge area of the window, observe the Pressure 
gauge. Wait about 5 minutes until the gauge achieves about 2.5 x 10-5. 
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Leak Checking 

Before running in the CI mode, confirm that the column is properly installed and the 
system is leak-free. The best way to check this is by running CI without the reagent gas. 

To leak-check the system: 

1. Display the Tune page. 

 

2. Select CI+ from the Ion Mode menu  



How to Set Up and Run Chemical Ionization 

317 

3. Click Press for Operate and observe the air/water masses.  

 

The CI source running in the CI mode without reagent gas to produce an EI 
emission similar to the EI mode but with reduced sensitivity. You will leak-
check your system this way.  
If mass 28 is larger than mass 18, you have a leak. Determine the source of the 
leak and correct it. For example, leak-check all fittings and connections. 
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Setting-Up CI 

After verifying that no leaks exist, you can proceed to set up the CI mode for an 
analysis. 

Setting the Parameter Values 

1. Display the following CI window:  

 

2. Set the values as shown above. 

The following table describes the CI parameters to check. 
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Adjust the Reagent Gas for CI+ 

When running in the CI+ mode with reagent gas off, the resulting EI spectra have 
about 10x lower sensitivity than with the EI source. 

If using methane reagent gas, the reagent ions at m/z 17 (CH5
+) and 29 (C2H5

+) 
should be of approximately equal intensity. Maximize the m/z 29 intensity. With 
m/z 29 maximized, the ion at m/z 16 should be about 1% of the m/z 17 peak height. 
(Higher indicates a leak at the transfer line/inner source connection.)  Operate 
slightly to the low-pressure side of the maximum to minimize gas load on the MS. 
(The pressure gauge reading will be 1.5x10-4 to 5x10-4 Torr.) 

If using ammonia reagent gas, reagent ions at m/z 18 (NH4
+) and 35 [(NH3)2H+] 

should be present and the ions at m/z 35 should be optimized. 

If using iso-butane reagent gas, the reagent ions at m/z 43 (C3H7
+) and 57 (C4H9

+) 
should be tuned in the approximate ratio of 1:2. 

The following example uses methane reagent gas. 

Parameter: CI+ Values and Comments: 
Electron energy 30 eV 
Emission Should be below 200 mA, although 200 to 300 mA is 

acceptable. (Above 200 mA may cause hydrocarbon 
“cracking” patterns with methane and iso-butane.)  Emission 
measures the real emission current, i.e. the source current from 
the source block, there is no trap "source current" in CI. 

Lens 1 and 2  The tuning of these lenses may be different from the optimum 
values set for EI, since the source pressure is much higher in 
CI. 

Multiplier 200V to 600V 
Ion Energy Approx. 1. Similar to EI. 
Source temperature 150 ºC 
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NOTE:  The CI gas adjustment knob controls a delicate needle valve. To avoid damaging the 
needle valve, do not overtighten it. Always use the CI gas button on the screen to 
turn off the CI gas. 

Reference
Gas Vial

(P/N E640-1384)

Knurled Nut

Access Door

Black Knurled Knobs

Inner Source

 
Figure 36 CI reagent gas adjustment knob 

1. Carefully turn the delicate CI Gas adjustment knob fully clockwise until you 
feel it stop. 
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2. Select CI Gas On from the Gas menu. A check mark appears next to the 
option. 

NOTE:  Always turn on the CI gas before Operate to avoid a pressure surge hitting the 
filament. 

3. Click Press for Operate and monitor the pressure gauge as you adjust the CI 
gas. Observe that mass 16 initially grows larger. As pressure increases in the 
ion chamber of CI source, the mass 29 peak will begin to grow. Keep the 
pressure below 5x10-4 Torr. 

4. When using methane gas, carefully turn the CI adjustment knob 
counterclockwise until m/z 16 is low or non-existent, and m/z 29 is maximized. 
As you turn the knob, reduce the multiplier voltage to keep the peaks on scale. 
A typical multiplier value is 235. 

m/z 17 and 29 will typically be 80 – 100%. 

5. Continue to turn the knob counterclockwise. Observe that the pressure 
increases and mass 41 will start to grow. Stop when mass 29 is at 100%. 

6. Turn the knob to maximize the intensity of mass 29. Also verify that mass 16 is 
small (< 1.0% of the height of the peak at mass 17). 
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If mass 16 does not appear as a small peak, STOP. You probably have a gas 
leak at the transfer line/inner source connection. Locate and correct the leak. 

7. After you have maximized the peak, slightly decrease the reagent gas by 
turning the knob clockwise 1/8 turn.  

8. Tuning may be optimized on the m/z 69, 219, 414, and 652 ions of the 
heptacosa reference gas. 
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9. Click Press for Standby to turn off Operate, followed by the CI gas. 
 
You are now ready to run your CI+ analysis. 

Adjust the Reagent Gas for CI- 

1. Open the CI gas inlet by selecting CI Gas from the Gas menu. Wait at least 10 
seconds before clicking Press for Operate. 
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Parameter:  CI− value and comments: 

Electron  Energy 30 to 70 eV 
(This parameter should be optimized.) 

Emission 200 to 300 μA is acceptable 
(Emission measures the real emission current, i.e. 
the source current from the source block, there is 
no separate measurement of source current in CI.) 

Lens 1 and 2  The tuning of these lenses may be different from 
the optimum values set for EI, since the source 
pressure is much higher in CI. 

Multiplier 200V to 600V 

Source temperature 150 °C is standard. Higher temperatures keep the 
source cleaner, but may increase fragmentation. 

For example, down a little from EI to minimize 
fragmentation. 120 °C is the practical lower limit. 

Ion Energy  Approx. 1 or 2 

2. Optimize the amount of reagent gas flowing into the source by using two 
heptacosa ions, m/z 452 and 633, which usually produce relative intensities of 
65 – 85% and 95% respectively. 
Heptacosa can be used to calibrate the m/z range for negative ion CI analyses. 

3. Maximize the peak intensities, then slightly decrease the reagent gas by turning 
the knob clockwise 1/8 turn. 
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Optimize the tuning parameters for maximum intensity. 

4. Save the Tune page parameters by selecting Save As…from the File menu. 

5. Select Calibrate Instrument from the Tune page Calibration menu. 

6. Select heptaneg.ref from the drop-down menu. 
 

 
CAUTION Make sure the “Use Air Refs” check box is not selected. 
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7. Click the Start button to display the following dialog box. 

 
 

8. Click Acquisition Parameters and enter the following values. 

 

9. Click OK to begin calibration. 
 
You are now ready to run CI analysis. 
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SIR Methods  

Selected Ion Recording (SIR, also called Selected Ion Monitoring or SIM) is 
primarily used to maximize sensitivity and may also be used to minimize the space 
required for recorded data. 

SIR enhances sensitivity because only the target ions of interest are monitored so 
that no time is spent recording non-target ions. Spending more time on the target 
ions increases the signal-to-noise (S/N) ratio by the square root of the increase in 
time spent monitoring the ion. For example, changing from a full scan acquisition of 
m/z 50 to 450 in 0.5 seconds to monitoring a single ion for the same period of time 
will increase the S/N by approximately the square root of 400, or 20. This can also 
be viewed as lowering the detection limit by a factor of 20. 

The following steps summarize the procedure for creating SIR methods. 

1. Acquire the data in full scan. 

2. Identify the target compounds. 

3. Determine the ions to monitor for each target compound. 

4. Enter these ions into the SIR Scan Functions in the MS method. 
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Creating SIR Methods with Multiple Functions 

Acquiring the data in Full Scan 

The following example uses a Grob-style capillary column test mix. Data were 
acquired from m/z 40 to 200. 
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Time0
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5.99

5.34

 

Figure 37 Data acquired using a Grob-style capillary column test mix  



How to Create SIR Methods 

331 

Identifying the Target Compounds 

Examining the spectra provides us with ions characteristic of each compound for 
quantification. These are shown below as mass chromatograms: 
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2.091.45 3.67

3.10
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Figure 38 Mass chromatograms of characteristic ions  

Determining the ions to monitor for each target compound 

When possible we try to monitor ions characteristic of the compound, as high in 
mass and intensity as possible. High mass is desirable to minimize the probability of 
chemical interference. High intensity is desirable for sensitivity. We also try to 
choose ions with low baselines for these same reasons. 
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From the above chromatogram, we will monitor the following ions over the 
specified time intervals. The fewer ions we monitor at any particular time, the more 
time we spend on each ion, and the better its detection limit. Although not done in 
this example, it is common practice to monitor at least three ions per compound. 
This allows later compound confirmation by ion ratio. Entering these ions into the 
SIR Scan Functions in the MS method 

Create Scan Functions 1 through 7 by entering data from the following table. 
 

Function Start (min) End (min) Ions Dwell (sec) 

1 1.30 1.70 57 0.08 

2 1.90 2.50 43, 58 0.10, 0.10 

3 2.80 3.40 70 0.25 

4 3.50 4.10 57, 107 0.10, 0.10 

5 5.20 5.60 106 0.25 

6 5.65 6.25 128 0.25 

7 6.40 7.00 43 0.25 
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Creating Scan Function 1 

To create the following seven scan functions, follow this procedure: 

1. Right-click on MS Method in sample list. From drop-down menu select Open. 

 

2. Select New from the File menu. 
The following dialog is displayed. 
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3. Create a SIR scan function by clicking SIR. 
The SIR dialog is displayed. 

 

4. Enter the Retention Window Start Time and End Time for Function 1 from 
the table on page 332. 

5. Enter 57 for Mass and 0.08 for Dwell. 
The Dwell time is the length of time this ion is monitored. This is normally set 
so that the sum of all the Dwell times for all the target ions gives about 10 
scans across the GC peak. 

6. Click Add to enter this ion into the scan table. 

7. To avoid being on the edge of the mass peak Gaussian curve, enter a Span of 
0.5 for the mass spectrometer to scan from m/z 56.75 to 57.25. 
The Repeats text box specifies the number of times we wish to execute this 
Function per pass. For example, if we had two Functions defined by their Start 
Time and End Time to execute simultaneously, and the first Function has 
Repeats = 1, while the second has Repeats = 3, then the second Function would 
execute three times for each time the first Function executed once. With non-
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overlapped Functions, better detection limits will be obtained by increasing the 
Dwell time rather than the number of Repeats. 

 

8. Click OK to enter this function into the MS Method. 
The following window is displayed. 
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Creating Scan Functions 2 through 7 

1. Click SIR and add the next line of data from the table on page 332. 

 

2. Enter Masses 43 and 58 sequentially (in the previous example we entered Mass 57). 

3. Click OK to save this Function to the MS Method. 
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4. Continue making entries in this manner until all of the Functions have been 
added. 
A screen similar to the following is displayed: 

 

5. Click the Solvent Delay button and enter a Solvent Delay of 1.0 minute until 
the filament is turned on. 

6. Select Save As from the File menu and give this function a name. 

7. You may now enter this SIR MS Method into the Sample List for data 
acquisition just as a Full Scan function. 

Acquiring data with this MS Method gives the following chromatogram. 
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Observe that there are now 7 discontinuous chromatogram Functions, as specified 
by the method. If you go into the Chromatogram window and open a chromatogram 
you will get only the first (bottom) trace. To load all of them you need to open all of 
the functions individually. You do this by selecting the down arrow next to the 
Function description. This will drop down a scrollable list of the available functions. 
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8. Select the Function you want and click OK. 
Doing this for all of the functions produces the chromatogram shown above. 

9. You may also overlay the traces by selecting the View entry from the 
Chromatogram window’s Display menu item, and selecting the Overlay 
Graphs style. 
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This generates the following overlaid chromatogram. 

1.50 2.00 2.50 3.00 3.50 4.00 4.50 5.00 5.50 6.00 6.50
Time0

100

%

simtmix1 6: SIR of 1 Channel EI+ 
TIC

2.39e6
5.98

 



 

 

 

How to Optimize
SIR Sensitivity 22 
 



 

 



How to Optimize SIR Methods 

343 

About Optimizing SIR Sensitivity 

SIR (Selective Ion Recording) is the most sensitive operational mode for a mass 
spectrometer.  It is often used for trace analysis.  This chapter discusses strategies 
for optimizing sensitivity and discusses some of the tradeoffs. 

The first thing you need to determine is if your analysis requires any further 
optimization.  If the current Tune gives you sufficient sensitivity for your SIR 
analysis you have no need to go further. 

If you need better detection limits you have two choices: 

• Optimize the tuning while retaining the same mass resolution. 

• Reducing mass resolution in trade for even better sensitivity. 

Your ability to take the second option depends on your chromatography.  If you 
have no background interferences from the vacuum system or nearby eluting GC 
peaks at adjacent m/z values, you can use the second. 
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To optimize SIR sensitivity: 

The following steps describe how to maximize your TurboMass SIR sensitivity.  
They are arranged in order of increasing effort.  You do not need to do all of them, 
just enough to get the sensitivity you need. 

Before you begin, read over the list and decide what approach is most appropriate 
for your needs. 

The last portion of this chapter summarizes the “normal” Tune guidelines for EI and 
CI.  SIR may vary from these guidelines in the pursuit of maximum sensitivity. 

1. Optimize the MS Method 

2. Optimize Lens 1 and Lens 2 

3. Optimize Repeller (EI only) 

4. Optimize Mass Resolution 

5. Optimize Ion energy 

6. Optimize Multiplier voltage 

7. Optimize Emission 

8. Optimize Electron Energy 

9. Optimize Ion Source Temperature 

10. Empirical Calibration 
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1. Optimize the MS Method. 

SIR sensitivity depends on the MS Method used.  Several approaches can be taken 
to maximize sensitivity. 

 

1. Choose the best ions for detection. In general, the higher the intensity and 
higher the mass the better.  Use the Chromatogram display of Full Scan data to 
look for the best S/N ions. 

2. Select the best Ionization Mode for your compound.  Different compounds 
may be more sensitive in one mode than another, and background interferences 
may be better or worse. 

3. Minimize the number of ions in a scan function.  A single ion will give the best 
performance, while 2 to 3 per compound may be desirable for compound 
identification.  At 10 or more ions, you may be better off with Full Scan. 

4. Maximize the Dwell time for each ion.   
 
Arrange you dwell times so that the sum of all the ion dwell times is about one-
tenth the GC peak width at base.  This will give you about 10 points across the 
GC peak – optimal for SIR sensitivity and GC peak area precision.  Fewer 
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points across the peak give better sensitivity at the expense of peak area 
precision.  More give lower sensitivity and do not significantly improve 
precision.  If you are monitoring ions of significantly different intensities, you 
may wish to assign a longer Dwell time to the less intense ion, because S/N 
increases proportionally to the square root of the Dwell time. 
 

5. Set the Peak Width at Half Height for Low and High Mass in UltraTune to a 
value higher than the 0.6 default (e.g., 0.8 to 1.0) if your analysis permits. If 
this does not provide enough sensitivity, then proceed to the following steps. 

2. Optimize Lens 1 and Lens 2. 

The lenses will affect peak shape and intensity.  They will also affect the relative 
intensities across the mass range. To optimize the lens: 

1. Enter the Tune environment. 

2. Turn on the Reference gas and Operate. 

3. Locate a peak (or peaks) in the Reference gas close to your target ion(s) of 
interest.  

4. Adjust Lens 1 to maximize the intensity of your chosen peak(s). 

5. Adjust Lens 2 to maximize the intensity of your chosen peak(s). 

6. Repeat steps 4 and 5 until there is no further improvement.  

3. Optimize the Repeller (EI only). 

The Repeller electrode “pushes” the ions out of the EI source.  Increasing its voltage 
can improve sensitivity, but it may also distort peak shape.  

To optimize the repeller: 

1. Continue from the last set of parameters. 
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2. Increase the Repeller voltage until you begin to see a significant change in 
peak shape, paying particular attention to the starting and trailing edges of the 
peak. 

3. If your sample permits you to reduce mass resolution, increase the Repeller 
voltage until the signal maximizes. 

4. Optimize the Mass Resolution. 

The LM Res (Low Mass Resolution) and HM Res (High Mass Resolution) control 
the width (resolution) of the ion peaks.   

To optimize the mass resolution: 

1. Continue from the last set of parameters. 

2. Increase the Gain on you peak(s) until you can see the isotope ion (one mass 
unit higher than the Reference gas ion) at about one-third of full scale intensity.  
Observe the depression, or valley between the two peaks.  In the picture below, 
the valley is about 20% of the height of the smaller isotope peak. 

20 % valley

 
Figure 39  Resolution of ions 

3. Lower the HM Res and LM Res until you see the valley increase to between 70 
and 80% of the isotope peak. HM Res has a stronger effect at high mass, and 
LM Res at low mass, but both influence across the mass range. 
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4. If your mass resolution requirements permit, you can reduce the resolution to a 
80 or 90% valley, and even go further and eliminate the valley entirely until the 
peaks become broader.  At some point, however, you may find that you cease 
to gain useful intensity while continuing to loose resolution. 

5. Optimize the Ion Energy. 

The Ion Energy and Ion Energy Ramp control the acceleration of the ions out of 
the ion source.  In graphical terms, the Ion Energy is the y-axis intercept and the Ion 
Energy Ramp is the slope of the line that defines this accelerating voltage.   

The effects of the two controls are interrelated.  If the Ion Energy is fairly low (e.g., 
below 1.0 V) increasing the Ion Energy Ramp will tend to increase the intensity of 
high mass ions relative to those at lower mass.  If the Ion Energy is high to begin 
with little affect may be seen.   

To optimize the ion energy: 

1. Continue from the last set of parameters. 

2. Increase first the Ion Energy Ramp and then the Ion Energy to increase signal 
intensity.  Pay attention to the peak width at base. If your mass resolution 
requirements permit, you may allow it to broaden. 

6. Optimize the Multiplier. 

The Multiplier voltage is a key factor in sensitivity and dynamic range.  Too low, 
and sensitivity can be severely reduced.  Too high and the baseline is raised, 
lowering the dynamic range. 

We will optimize it for both sensitivity by setting it to a value which maximizes the 
signal-to-noise ratio of a peak near the baseline, and dynamic range by keeping the 
baseline noise as low as possible.  

To optimize the multiplier: 

1. Set the Multiplier voltage to 350, and select the Reinitialize option from the 

Other menu, or press the  icon to reinitialize the baseline. 
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2. Look in the residual vacuum spectrum and find a small mass peak near your 
target mass of interest. It should be near the noise level. If you do not see one, 
let in the Reference gas and look at its spectrum.  An example is m/z 495 in the 
reference gas. 

3. Increase the Multiplier voltage in 50 V steps to 700 V.  Reinitialize after each 
voltage step.  The signal will increase, but so will the noise.  You will need to 
decrease the Gain of the display to keep the peaks at about the same height. 

4. Continue doing this until you find that increasing the Multiplier voltage no 
longer increases the ratio of the peak signal to the surrounding noise.  That is 
your optimal Multiplier voltage.  Increasing the voltage will not gain you any 
sensitivity, only decrease you dynamic range.  Typical values are 400 to 600 V. 

7. Optimize the Emission. 

The Emission setting controls the amount of electrical current flowing through the 
filament.  Adjusting this can significantly change your signal intensity.  The trade-
off is filament lifetime.  In general, try to keep the Filament Current under 3.6 to 
3.8 Amps.   

To optimize the emission: 

EI and CI- often can give improved performance at higher Emission settings.  
Methane and isobutane CI+ may not because of increased noise related to 
hydrocarbon fragmentation patterns. 

1. Continue from the last set of parameters. 

2. Increase or decrease the Emission to maximize signal-to-noise ratio. 
Reinitialize the baseline level after each step.  Keep the current under 3.5 
Amps. 

8. Optimize the Electron Energy. 

The E Energy (Electron Energy) is the potential energy of the electrons striking the 
analyte (or reagent gas, for CI).  For EI, a value of 70 eV is normally used.  
However, the value for optimum sensitivity is compound and ion-dependent.   
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To optimize the electron energy: 

1. Save your new Tune method. 

2. Create and save a series of new methods at 10 V increments. 

3. Shut down Tune.  

4. Add the MS Tune File column to your Sample List spreadsheet. 

5. Acquire a series of injections of your analyte specifying the different Tune files 
you just created. 

6. Compare the S/N ratios of chromatographic results for the target ions, and select 
the MS method with the Electron Energy that gives the best results. 

9. Optimize Ion Source Temperature. 

The Source Temperature can have an effect on relative ion intensity.  In general, a 
lower temperature will give more intense high-mass ions, particularly the molecular 
ion.  The tradeoff is that the source may become contaminated more rapidly, 
requiring more frequent cleaning.  Very high boiling point compounds may exhibit 
GC peak tailing at low ion source temperatures. 

A temperature of 150 ºC is probably close to the lowest practical temperature 
setting, since the filament and GC transfer line will make it difficult to keep the 
temperature stable at a lower value.   

To optimize the source temperature: 

1. Save your new Tune method. 

2. Create and save a series of new methods with the Source Temperature at 
10 ºC increments. 

3. Shut down Tune.  

4. Add the MS Tune File column to your Sample List spreadsheet. 
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5. Acquire a series of injections of your analyte specifying the different Tune files 
you just created.  Allow enough time between each injection for the 
temperature to equilibrate (perhaps 20 minutes). 

6. Compare the S/N ratios of chromatographic results for the target ions, and 
select the MS method with the Source Temperature that gives the best results. 

10. Empirical Calibration. 

The normal operation of SIR is to set the Span to m/z 0.25 to 1.0 so that the MS 
sweeps this over this range for each SIR ion.  (For example m/z 100 with a Span of 
m/z 0.5 would sweep from 99.75 m/z to 100.25 m/z).  This ensures that the MS peak 
top is covered in the sweep.  The cost is that less time is spent at the maximum 
intensity point of the peak.  Reducing the Span to 0.0 will improve sensitivity if the 
target Mass is exactly on the top of the peak. 

To make sure the target Mass is exactly on the top of the peak we use the technique 
of Empirical Calibration.  This is done in the following manner. 

1. For each target Mass, create a SIR Function in the MS Method which scans at 
least five ions over the expected mass (calculated with the MW Calculator on 
the Sample List Tools menu as the Mass).  If, for instance, this value were 
100.0 Da, then the SIR ions would be m/z 99.6, 99.8, 100.0, 100.2, and 100.4.  
(You may do this for multiple compounds in the same Function). 

2. Acquire the chromatogram.   

3. Plot the resulting selected ion traces, specifying to mass to m/z 0.05. 

4. Choose the plot with the highest intensity as the Mass for your method. 
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11. Typical Operation Parameters 

Parameter EI Value CI+ Value CI− value 

Electron Energy 70 eV 30 eV 30 eV to 70 eV 

Emission (trap 
current for EI) 

50 to 200 μA  (Leave as 
low as possible.) 

< 200 mA, although 200 to 
500 mA is acceptable. 

< 200 mA, although 200 to 
500 mA is acceptable. 

Filament current 3.0A to 4.2A.  
(At 5 A the filament will 
have a reduced lifetime.) 

same same 

Ion energy 0.0 to 2.5 same same 

Ion Energy Ramp ~ 1.0 to 3.0 eV ~ 1.0 to 3.0 eV ~ 1.0 to 3.0 eV 

Lens 1 and 2   The tuning of these lenses 
may be different from the 
optimum values set for EI, 
since the source pressure is 
much higher in CI. 
Optimal values change 
with pressure and mass 

The tuning of these lenses 
may be different from the 
optimum values set for EI, 
since the source pressure is 
much higher in CI. 
Optimal values change 
with pressure and mass. 

Multiplier 220V to 600V same same 

Repeller 0 to 1.5V (Keep as low as 
possible.) 

0 V 
(Not present in the CI 
source.) 

0 V 
(Not present in the CI 
source.) 

Resolution 
(LM/HM) 

~ 10/12; varies with the 
mass spectrometer; (Need  
a minimum 50% valley 
between 12C/13C isotopes.) 

same same 

Source current 
(emission) 

Twice the emission current 
or higher. 

N/A N/A 

Source temperature 150 to 220 °C 
(Lower temperatures 
minimize fragmentation.) 

150 ºC 150 ºC 
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Common Vacuum System Contaminants 
 

M/z Species Common Source 

12 C+ Organic contamination 

13 CH+ Organic contamination 

14 N+ Air leak, contaminated gas tank 

14 CH2
+ Organic contamination 

15 CH3
+ Organic contamination 

16 O+, CH4
+ Air leak, contaminated gas tank 

17 OH+ Air leak, contaminated gas tank, water 

18 H2O+ Air leak, contaminated gas tank, water 

19 H3O+ Air leak, contaminated gas tank, water 

19 F+ Heptacosa reference gas 

20 Ne+, HF+ Contaminated gas tank 

23 Na+ Human fingerprint oils 

26 C2H2
+ Organic contamination 

27 C2H3
+ Organic contamination 

28 N2
+, CO+ Air leak, contaminated gas tank 

28 C2H4
+ Organic contamination 
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M/z Species Common Source 

29 14N15N+ Air leak, contaminated gas tank 

29 CHO+, C2H5
+ Organic contamination 

31 CF+ Heptacosa reference gas 

32 O2
+ Air leak, contaminated gas tank 

39 K+ Human fingerprint oils 

40 Ca+ Human fingerprint oils 

40 Ar+ Air leak, contaminated gas tank 

40 C3H7
+ Organic contamination 

44 CO2
+ Air leak, contaminated gas tank 

44 C3H8
+ Organic contamination 

69 CF3
+ PTA calibration gas 

73 Me3Si+ GC column or septum bleed 

149 Phthalate Plasticizer from plastics 
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Ion Series Common Sources 

73, 147, 207, 221, 281, 295, 355, 429 Methyl silicone – septa and columns 

19, 31, 69, 131, 219, 264 Heptacosa reference gas 

43, 57, 71, 85 Alkane series 

41, 55, 69, 83 Alkene series 

41, 43, 55, 57, 69, 71, 83, 85 Human fingerprint oils 

77, 94, 115, 141, 168, 170, 262, 354, 446 Diffusion pump fluid 
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Installing a Column Without Removing the 
Source 

This is an alternate procedure, designed so that you can change columns without 
removing the source from the mass spectrometer. 

Connecting the other end of the new column to the 
TurboMass 

After conditioning the GC column, connect the other end of the column to the mass 
spectrometer via the transfer line by following the procedure described below. 

The mass spectrometer heated transfer line prevents the sample from condensing in 
the fused-silica analytical column on its way to the ion chamber. The GC end of the 
transfer line is fitted with a Swagelok coupling and a graphite/Vespel ferrule to 
ensure a gas-tight seal between the column and the transfer line. Do not use graphite 
or stainless steel ferrules on the column. 

1. Uncoil about 50 cm (20 inches) from the new column and place the column on 
the column hanger in the oven. 

50 cm

Column

 
Figure 40 Uncoiling 50 cm from a column 
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2. Slide the high temperature septum, 1/16 inch column nut (P/N 09903392), and 
1/16 inch graphite/Vespel ferrule (0.8 mm i.d., P/N 09920107, 0.25 mm i.d., 
P/N 09920104, or 0.325 mm i.d., P/N 09920105) over the end of the column. 

Column

1/16-inch Column Nut

Column 
Septum

1/16-inch 
Graphite/Vespel 
Ferrule

 
Figure 41 Inserting a septum, column nut, and ferrule on a column 

3. Slide the septum, column nut, and ferrule along the column to the position 
shown below. 

4. Score and break 1 cm off the end of the column. Wipe the column with a 
methanol dampened lab tissue (for example, a Kimwipe). 
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1 cm

Use glove.

Cut end of column
off here

Column

Slide the septum, column nut,
and ferrule to this position.

Wipe the column 
with a Kimwipe
dampened with MeOH.

1.

3.

2.

 
Figure 42 Preparing to install the column in the transfer line 

5. Carefully insert the end of the column through the transfer line and into the 
mass spectrometer source until you feel it hit the wall of the source. 
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Transfer Line

Insert Column into Transfer Line

2 mm or midway 
between the hole 

and the wall

Column End

Wall

Hole

Clarus 600
Gas Chromatograph

Clarus 600
Mass Spectrometer

 
Figure 43 Inserting the column end in the source assembly (shown with the 
source removed for clarity) 

6. Hold the column in this position as you slide the column nut and ferrule to the 
transfer line and tighten the nut fingertight. 

NOTE:  Fingertight means just tight enough to hold the column in place but still allow you 
to move the column slightly if necessary to reposition it. 
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7. Mark the position by sliding the septum until it is flush against the rear of the 
column nut. 

 

1/16-inch Column Nut1/4-inch Column Nut

Septum

 
Figure 44 Marking the column position in the source 

8. Pull the column back until the distance between the back of the nut and septum 
is 10 to 11 mm. 
This assures that the column end will be flush with the inner wall of the ion 
volume to produce optimized results. 

NOTE:  This is a very critical step during column installation. If the end of the column is not 
precisely positioned in the ion source, decreased sensitivity can occur. 
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metric
10 20 30 40 50 60 70 8

Slide the column back until the 
septum is 10 mm from nut.

1/16-inch Column Nut Septum Column

 
Figure 45 Pulling the column back to the proper position in the source 

9. To make a leak-free seal, insert a 5/32 inch wrench over the flats on the transfer 
line and with a ¼ inch wrench, tighten the column nut ¼ turn past fingertight. 
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1/16-inch Column Nut 
Flats for the 5/32-inch 

(4 mm) on the transfer line.  
Figure 46 Tightening the column nut 

10. Start the carrier gas flowing and check for gas leaks. 
Using an electronic leak detector, start at the supply gas tank and test every 
fitting up to the injector connection inside the GC oven. 

11. Start the vacuum by selecting Pump/Vacuum System On from the Other 
menu on the Tune window. 
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Monitor the vacuum and check for vacuum leaks if necessary. See How to Leak 
Check the System on page 97. 

12. Once you are confident that no leaks exist, set the injector and transfer line 
temperatures to their desired values, heat the ion source, and close the GC oven 
door to heat the column. 

Equilibrating the system 

After installing the column, equilibrate the system for a new column by following 
this procedure. 

1. Cycle the GC through one temperature cycle. 

2. Open the oven door and, using a ¼ inch wrench, tighten the column nuts 
slightly. 

3. Check for leaks. 
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Index 

A 
Acquire, mass chromatogram, 200 
Analytes, 195 
Auto Control Tasks, 301 
Automatic Shutdown, 300 
AutoTune, 128 

B 
Background subtraction, 27 
Basic GC/MS, 20 
Browser, Report template, 258 

C 
Calibration, chromatographic 

library, 196 
CI 

gases, 313 
leak checking, 316 
setting parameter values, 318 
setting up, 318 

CI Ion sources, 308 
Cold state 

carrier gas, 48 
hardware, 43 
starting, 43 

Collections, 263 
Column 

clean vs. bad cuts, 83 
conditioning, 86 
connecting to injector, 81 

connecting to TurboMass, 87, 361 
equilibrate the system, 96, 368 
installation summary, 72 
installation tools and materials, 73 
preparing to install, 74 
selection, 68 

Column variables 
column internal diameter, 70 
column length, 71 
stationary phase, 69 
stationary phase thickness, 70 
type of samples, 69 

Communiqué, 263 
Computer requirements, 34 
Configuring the GC, 53 
Conventions used, 36 

D 
Data object Indexing, 280 
Diffusion pump, 15, 17 
Display chromatogram, 180 

E 
EI to CI mode changing, 312 
Electrical connections, 43 
External standard, 194, 195 
External standard method, 194 

G 
GC 

column selection, 68 
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configuring, 53 
GC Method 

developing, 143 
Method Editor, 143, 151 
parameters, 145 

GC Method file, *.mth, 150 
GC settings 

for TurboMass, 48 
GC/MS 

background subtraction, 27 
conclusions, 32 
connection between, 24 
identifying a series of compounds, 30 
identifying components, 28 
identifying specific compounds, 30 
introduction to, 20 
recording mass spectra, 24 
using scan data, 27 

I 
Injection 

size variations, 194 
split, 162 
splitless, 163 
techniques, 159 

Integration and peak selection, 240 
Interactive Data Review, 235 
Interface, selecting the GC, 54 
Internal standard 

defined, 195 
Internal standard method, 194 
Ion sources 

about CI, 308 
about EI, 308 
EI parameters, 310 

L 
Leak checking, 99 

CI, 316 
Library search, 186, 241 
LINK 

information, 55 

M 
Maintenance 

leak-checking, 99 
Mass Calibration 

naming the file, 137 
Menu 

System Control, 48 
MS Method 

centroid, 153 
continuum, 153 
multi-channel analysis, 153 

MS scanning method, .mdb, 154 

N 
NIST Library, 28 

O 
Overview 

GC/MS, 20 

P 
Prerequisites, tutorial, 12 
Process Quantification Results, 229 
Projects 

about, 118 
DEFAULT.PRO, 122 
subdirectories, 118 
use existing as template, 121 

pumps 
pump down, 95 
venting diffusion pump, 297 
venting turbo pump, 297 

Q 
Qualitative Method, 239 
Qualitative Method Editor, 243 
Qualitative process, 240 
Quantification 

creating the method, 201 
run the samples, 200 
Sample List, 198 
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Quantify 
List by Compound, 234 
List by Sample, 234 
processing samples, 230 
view results, 233 

Quantitation, 195 

R 
Report Method Editor, 255 
Report Template Browser, 258 
Report template, new, 272 
Resolution enhancement, 29 
Response Factor Curve, 195 
Run samples, 200 

S 
Safety and regulatory information, 12 
Sample List 

building, 167 
creation, 198 

Scan data, about, 27 
Search, 186 
Search parameters, 245 
Shut Down 

automatic, 300 
long-term, 297 
overnight, 292 
weekend, 297 

SIM, method, 329 

SIR, method, 329 
Split injection, 162 
Splitless injection, 163 
Start pumping, 94 
Starting TurboMass, 43 
Stationary phase, 69 
Syringe 

rinsing, 159 
sample loading, 160 

System Control Menu, 48 
system requirements, 35 

T 
Target compound, 195 
Template, Report Browser, 258 
Touch Screen, 38 
Tuning, 127 
TurboMass 

system requirements, 35 
Turbomolecular pump, 14 

V 
Vacuum system 

diffusion pump, 15, 17 
turbomolecular pump, 14 

venting, 297 
diffusion pump, 297 
turbo pump, 297 
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